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I. Introduction and Objectives 

Oysters and the reefs that they form present unique management challenges as one of very 
few ecosystem engineers that are directly subjected to harvest. Harvest not only removes 
individuals from the population, but also removes shell and three-dimensional reef structure, 
thereby limiting settlement habitat for oyster larvae, reducing habitat value for reef-dwelling 
organisms, and often reducing the resilience of reefs to additional stressors (e.g., 
sedimentation, anoxia). Indeed, following more than a century of harvest, in combination with 
disease and poor water quality, oyster reefs have been labeled one of the most imperiled 
marine habitats on earth. To better manage and restore oyster reefs, resource managers and 
restoration practitioners have expressed a need for novel approaches to better monitor and 
assess the resource. 

Oyster reefs are primarily managed by state agencies to sustain fisheries; however, the 
importance of regulating (e.g., nutrient remediation, shoreline stabilization) and supporting 
(e.g., nursery habitat) ecosystem services are increasingly gaining recognition. Along the south 
Atlantic bight of the United States (i.e., North Carolina to Florida), the focal geography of this 
project, Crassostrea virginica oyster reefs occur primarily in the intertidal. Oyster resource 
managers and restoration practitioners from NC to FL (primary end users of this project) often 
rely on the mapping (e.g., boat-based surveys or remote sensing) and monitoring (e.g, in situ 
quadrat sampling) of intertidal reefs to inform management decisions, such as fishery closures, 
and where to “plant” shell or other alternative materials to provide recruitment substrate for 
oyster reef restoration and habitat enhancement efforts. However, these methods can be time-
consuming, labor intensive, destructive to the reef, and limited by spatial scale (e.g., m2 
quadrats) or resolution (e.g., satellite pixel size). 

Both resource managers, applied researchers, and National Estuarine Research Reserve (NERR) 
staff end users in the region have expressed a need for rapid, standardized, and quantitative 
measures to assess reef structural and demographic characteristics for monitoring, managing 
and restoring the resource in both habitat and fishery contexts. For our purposes, we are 
defining structural and demographic characteristics as two-dimensional (e.g., footprint) and 
three-dimensional (e.g., rugosity) physical metrics and metrics such as oyster density, all of 
which provide information on reef ‘condition’. 

In this project, we evaluated Uncrewed Aircraft Systems (UAS) as a tool for providing 
quantitative measures of intertidal eastern oyster reef structural and demographic metrics and 
changes to reefs in response to natural and anthropogenic factors. We developed and 
implemented an integrated collaborative and technical process with oyster resource manager 
end users from the Florida Fish and Wildlife Conservation Commission, Georgia Department of 

https://nerrssciencecollaborative.org/project/Kingsley-Smith22
https://nerrssciencecollaborative.org/project/Kingsley-Smith22
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Natural Resources, South Carolina Department of Natural Resources, and North Carolina 
Division of Marine Fisheries, as well as end users from all five NERRs in the southeastern U.S. 
(North Carolina, North Inlet-Winyah Bay, ACE Basin, Sapelo Island, and GTM Reserves). End 
users prioritized the following metrics: 1) reef height and elevation, 2) rugosity, 3) reef footprint 
and area, 4) shell substrate and oyster percent cover, 5) shell volumetric change, and 6) oyster 
density and size structure. 

Detailed image analysis workflows for each priority metric are presented in this document. The 
workflows were developed following drone-based surveys of multiple reef types (e.g., fringe vs 
patch reefs) and management regimes (e.g., open vs closed to harvest). The drones used in 
surveys were equipped with stock red, green, blue scale sensors flown at an altitude generating 
a ground sampling distance of ~ 1cm/pixel. Imagery was processed using structure from motion 
photogrammetry software. The resulting orthomosaics and/or digital elevation models are 
generally required as inputs for each workflow. Workflows were developed using ArcGIS Pro 
and Microsoft Excel. This document is targeted at entry-level UAS users with UAS training and 
required certifications (e.g., FAA Part 107 certificate) that are interested in exploring UAS as a 
tool for monitoring intertidal reefs. The document does not include image acquisition or 
processing guidance. These workflows are selected from many potential metrics and are 
examples of approaches that are likely to be generally useful for managers and restoration 
practitioners. Users are encouraged to refine, adapt or otherwise use these workflows as 
starting points to develop useful approaches for particular needs or programs.  
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II. Oyster Reef Elevation and Elevation Change 
Workflow 
 
Workflow lead and contact: Brandon Puckett (brandon.puckett@noaa.gov) 
 

Overview 
1. Pre-checks 
2. Extracting Elevations from DSM for Groundpoints 
3. Calculating Model Accuracy and Conduct Regression Analysis 
4. Adjusting DSM and Displaying Point Accuracy in ArcPro 
5. Calculating elevation change limit of detection (need two DSMs in a time series) 

1. Pre-checks 
● Before beginning any analyses, it's a good idea to conduct a few simple pre-checks: 

○ Check the alignment of the outputs generated from imagery processing, 
particularly if comparing orthomosaics and digital elevation models over time. 
■ To add orthomosaics to a project, right click on ‘Folders’ in the catalog pane 

→ add folder connection and then navigate to the location where your 
orthomosaics are located. Right click on each orthomosaic file and select ‘add 
to new map’ or ‘add to current map’.  

■ Use the ‘swipe’ tool in the Raster Layer pane to make sure both 
orthomosaics are aligned. Swipe horizontally and vertically and cue on marsh 
shorelines, ground control points, landing pads or any other stationary 
objects in both orthomosaics. If there are offsets between orthomosaics 
between pre- and post-excavation orthomosaics, then it's likely an error with 
ground control points (i.e., coordinate may have been entered incorrectly for 
a GCP for one image set).   

● Coordinate system check 
○ In the contents pane, right click on each raster, select properties → source → 

select the spatial reference dropdown. Ensure the projected coordinate system is 
NAD 1983 (2011) UTM Zone XX (where XX is the appropriate zone for your 
location). Linear units should be in meters. The vertical coordinate system should 
be NAVD88 in meters. Repeat for each orthomosaic.  
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2. Extracting Elevations from DSM for Groundpoints 
Determine ArcGIS project structure–Prior to starting, decide whether all sampled reefs will be 
housed in the same ArcGIS project (e.g., each reef will have a separate Map tab), or if each 
ArcGIS project will house an individual reef. Note, your decision will affect the naming 
convention of the final exported ArcGIS project(s) specified at the end of the workflow. 
 

1. ADD DSM to the current map (as above) or Drag/Drop DSM into the contents pane. May 
need to wait for “Calculating Statistics” to finish 

2. Under the Map tab at the top, Add data, navigate to file with RTK survey data (.csv).  
a. CHECK the RTK file to make sure elevations from ground control points (GCPs), 

RTK points taken on top of pvc quadrats, checkpoints, benchmarks, VRS/RTN 
stations, and groundpoints taken in water are NOT included for vertical accuracy 
assessment of digital surface models (DSMs). RTK data collected from haphazard 
shots throughout the reefs, shots along the rugosity chain(s), and shots along 
axial reef profiles can all be used as groundpoints for this exercise.  

3. Right click .csv file → Create Points from Table (note: older versions of ArcPro may use 
‘display x/y’)→ choose “XY Table to Point” →  make sure the coordinate system is 
correct (make sure coordinate system matches the DSM) → assign “x field” to Easting, 
“y field” to Northing, and “z field” to Elevation columns 

4. Under “Analysis” tab, click the geoprocessing toolbox 
5. Type in “Extract values to points” and double click that tool to use. 

a. For input point features, find the groundpoint data that was added in step 3.  
b. For input raster, use the DEM of interest.  
c. Make sure to keep the output point feature unchanged except for the last bit 

after “.gdb\”. Anything after the “.gdb\” will be the name of the point feature 
once the tool finishes.   

d. If you prefer not to change anything, you can always change the name of the 
point file after it is done running/shows up in the contents section. 

e. Click Run 
6. Under the geoprocessing toolbox, type in “Table to excel”.  
7. Select the point file you just created using the “extract values to points” tool.  

a. To output the excel file, find the folder/path you’d like to save under and give 
the file a unique name. 

b. Click Run. 
Repeat the steps above for each dataset in a time series at a given reef.  
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3. Calculating Model Accuracy and Conduct Regression Analysis 
8. Open the excel file created in the “extract values to points/table to excel” (hereafter 

referred to as EVTP; step 7).  
9. Create a new column next to the “RASTERVALU” column named “Diff”.  

a. The base value should be nonexistent 
10. In the first row under Diff, calculate the value of the difference between the measured 

RTK elevation and DSM RASTERVALU ( =elevation-rastervalu).  
11. Apply the excel formula to all points in the file (double click on the right bottom corner 

of the cell).  
12. Create another column which will be the Diff^2 (i.e., squared error).  

a. The cell formula should look like “=G2^2” where cell G2 contains the Diff value.  
13. Make sure this is applied to every point as well.  
14. At the bottom of the spreadsheet, use the “=count” formula and count the number of 

elevation points.  
15. To calculate the model vertical accuracy, we’ll calculate the root mean squared error 

(RMSE), which is the square root of the sum of squares error divided by the number of 
elevation points: 

 
a. The formula in excel would look like “=sqrt(sum(H2:H87)/J88)” where 

sum(H2:H87) is the sum of squares (sum of Diff^2 column) and J88 is the count 
or number of elevation point.  

16. The RMSE provides an estimate of model vertical accuracy in meters. This estimate of 
accuracy is in addition to the estimate derived from image processing software when 
using checkpoints.  

17. Multiply by the RMSE value by 100 to convert RMSE to units from meters to cm. 
18. For the regression analysis, plot RTK measured elevation (“elevation”) vs DSM predicted 

elevation (“rastervalu”). Right click on the points, select “add trendline”, choose linear, 
and check boxes for “display equation on chart” and “display R-squared value on chart”. 
Ideally, the slope is ~1 and y-intercept is ~0 (see example in Figure 1).  

19. Run a regression analysis in excel by clicking on the data tab � data analysis � regression 
(note, you will need the analysis toolpak in excel to do this. To add the toolpak, click on 
File � options � add-ins. In the table of Inactive Application Add-Ins, click on “Go…” at 
the bottom of the window next to Manage Excel Add-Ins. Then check the box for 
Analysis ToolPak, and click “OK”). Input Y range = DSM elevations (“rastervalu”), input X 
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range = RTK elevations (“elevation”). Also, a good idea to check the box for ‘residual 
plots’. Select output range (which cell you want output started on), otherwise a new tab 
will be created for the regression output.  

 
Figure 1. Example observed vs predicted elevation plot. The red dashed line is the 1:1 
line.  
 

20. Plot the RTK measured elevation vs DSM error (“Diff”) and look for bias (see examples in 
Figure 2). Are all the errors positive? Negative? Hopefully not, otherwise the DSM has a 
systematic (non-random) bias in it such that the DSM is always below or always above 
the in-situ RTK ground points. Errors consistent along all observed elevations?  
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Figure 2. Example DSM error plots. Notice bias in error in top panel whereby errors are 
generally negative at low RTK measured elevations and generally positive at high RTK 
measured elevations (i.e., overpredicting elevations at low elevations and 
underpredicting at high elevations). In contrast, the bottom panel has minimal bias with 
DSM error distributed ~ equally across RTK measured elevations. As detailed below, 
correcting model error for examples like the top panel will likely require both a slope 
and y-intercept adjustment of the DSM, whereas correcting model error for examples 
like the bottom panel may only require a y-intercept adjustment of the DSM.   

 
21. Calculate RMSE for two additional scenarios: 1) with DSM (“rastervalu”) elevations 

adjusted by the y-intercept of the regression only and 2) with DSM (“rastervalu”) 
elevations adjusted by the slope and y-intercept of the regression. Insert 6 columns. 
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Name them rastervalu_yint_correct, diff_yint_correct, diff^2_yint_correct, 
rastervalu_slope_yint_correct, diff_slope_yint_correct, diff^2_slope_yint_correct.  

22. To calculate values for the rastervalu_yint_correct column, subtract the y-intercept from 
the original DSM elevations (rastervalu-(y-intercept)). Use the Intercept value 
(coefficient) reported in the Regression table (step 19). Then follow steps 10-17 to 
calculate the RMSE for the y-intercept adjusted DSM. 

a. Generate new versions of Figures 1 and 2 (steps 18 and 20). 
23. To calculate values for the rastervalu_slope_yint_correct column, subtract the y-

intercept from the original DSM elevation (rastervalu) and divide the difference by the 
slope (=(rastervalu – (y-intercept))/slope). Use the slope and intercept value reported in 
the Regression table (step 19). Then follow steps 10-17 to calculate the RMSE for the 
slope and y-intercept adjusted DSM. 

a. Generate new versions of Figures 1 and 2 (steps 18 and 20) 
24. Compare RMSE and DSM error plots (e.g., figure 2) for the original DSM, y-intercept 

adjusted DSM, and slope and y-intercept adjusted DSM. The ‘best’ scenario hopefully 
generates a detrended DSM error plot (e.g., bottom panel of figure 2) and the lowest 
RMSE.  Note, there may be instances where the RMSE is similar among scenarios (i.e., 
within 0.5cm). In that case, choose the best option based on the DSM error plot. This 
‘best’ scenario will be used to adjust the DSM raster in ArcPro and to calculate elevation 
and volumetric change limits of detection.  

25. Save the excel file (.xlsx).  

4. Adjusting DSM and Displaying Point Accuracy in ArcPro 
26. Return to your ArcPro project with DSM and extract values to points layers in the 

contents and displayed on the map. 
27. Under “Analysis” tab, click the geoprocessing toolbox, type in ‘raster calculator’ 
28. If adjusting the DSM by y-intercept only (based on step 24)… 

a. double click the DSM in the raster box, double click the subtraction sign “-“ in the 
tools box, type “(“ in the expression box, enter in the y-intercept from step 19), 
type “)” in the expression box. The formula should look something like this: 
"tm_100ft_rgb_post_dsm_cs.tif" - (0.001652811) where 0.001652811 is the y-
intercept.  

b. Name the output raster as desired (with e.g., yint_corrected at end of file name).  
c. Click Run 

29. If adjusting the DSM by slope and y-intercept (based on step 24)… 
a. in the expression box, type “(“, double click the DSM in the raster box, double 

click the subtraction sign “-“ in the tools box, type “(“ in the expression box, 
enter in the y-intercept from step 19), type “)” in the expression box, type “)”, 
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double click the division sign “/” in the tools box, enter in the slope from step 19. 
The formula should look something like this: ("tm_100ft_rgb_post_dsm_cs.tif" - 
(0.001652811))/0.944468743 where 0.001652811 is the y-intercept and 
0.944468743 is the slope.  

b. Name the output raster as desired (with e.g., slope_yint_corrected at end of file 
name).  

c. Click Run 
30. Under “Analysis” tab, click the geoprocessing toolbox 
31. Type in “Extract values to points” and double click that tool to use. 

a. For input point features, find the groundpoint data that was added in step 3.  
b. For input raster, use the adjusted DSM created in step 28 or 29.  
c. Make sure to keep the output point feature unchanged except for the last bit 

after “.gdb\”. Anything after the “.gdb\” will be the name of the point feature 
once the tool finishes.  

d. If you prefer not to change anything, you can always change the name of the 
point file after it is done running/shows up in the contents section. 

e. Click Run 
32. Under the geoprocessing toolbox, type in “Table to excel”.  
33. Select the point file you just created using the “extract values to points” tool.  

a. For the output excel file, find the folder/path you’d like to save under and give 
the file a unique name. 

b. Click Run 
c. Open the excel file and check to make sure the corrected DSM elevations 

(RASTERVALU) match with what you calculated for rastervalu_yint_correct (step 
22) or rastervalu_slope_yint_correct (step 23).  

34. Right click the point file created in the “extract values to points” (step 31), select 
“Attribute Table” 

35. Select “Add”, to create a new field to calculate the difference between RTK measured 
elevations and DSM corrected elevations. Type in the new field name (i.e., Diff_Corr), hit 
tab to move to the next column and put the same thing for the “Alias”.  

a. Tab again to select the “Data Type”.  
b. Make sure the data type is “Double”.  
c. Finally click the “number format” column and click the 3 dots (…) that appear in 

the right side. A window with the Number Format Category will appear.  
d. Click the drop-down arrow and choose “Numeric” for Category and leave 

everything else as is.  
e. Click OK.  
f. Exit the table and be sure to save all changes when prompted.  
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36. Now you’ll have a newly added blank column (with null values).  
37. Click “Calculate”, make sure the newly created field name (i.e., Diff_Corr) is selected.  
38. Click in the white box with fields and then double click “elevation” under fields, then 

click the subtraction sign, and finish by double clicking “rastervalu” so that the formula 
reads “$feature.Elevation - $feature.RASTERVALU”.  

39. Click Apply and then OK. 
40. Right click the EVTP point file and click “Symbology”.  

a. Change primary symbology to “Graduated Colors”, and change the field to 
whatever field name you added in step 35.  

b. Change the number of classes to however many you need/want, as well as 
adjust the values/limits for each class as needed.  

c. Symbol size/shape/color can also be changed by clicking on the symbol itself.  
d. Look for any spatial biases–are all the largest residuals around the edges? Are 

negative residuals spatially clustered, etc? 
41. Exporting ArcGIS project (.ppkx) 

- Exported elevation projects are located at the following path: 
\imagery_analysis_arcgis_packages\xxx\elevation (where xxx = reserve initials) 

a. Share tab → Project (left side). 
● Start packaging = “Save package to file”. 
● Item details = change the file location and name, as appropriate. 

1. If the projects are reef-specific, save the files as: 
xxx_zz_mmddyy_elevation.ppkx, where xxx = reserve initials, zz = reef 
initials, mmddyy = date sampled (e.g., 
noc_mm_071423_elevation.ppkx). 

2. If the projects are workflow-specific, and contain all reefs, save the file 
as: xxx_allreefs_yyyy_elevation.ppkx, where xxx = reserve initials, yyyy 
= year sampled (e.g., noc_allreefs_2023_elevation.ppkx). 

3. For the experimental reefs, save the files in one of the two formats 
listed above, and add ‘_experiment.ppkx’ at the end of the name (e.g., 
noc_mm_030824_elevation_experiment.ppkx). 

● Select the checkbox for “Share outside of organization”. Make sure all other 
checkboxes are unselected. 

 

5. Calculating elevation change limit of detection 
 -Note: limit of detection calculations require two DSMs in a time series.  

42. Elevation change limit of detection calculation based on: Lane et al. 2003 and applied in 
James et al. 2017 and Dale et al. 2020.  

https://onlinelibrary.wiley.com/doi/pdf/10.1002/esp.483
https://onlinelibrary.wiley.com/doi/pdf/10.1002/esp.4125
https://onlinelibrary.wiley.com/doi/pdf/10.1002/esp.4125
https://www.sciencedirect.com/science/article/pii/S0925857419304197/pdfft?md5=19de8d3f4be207115535111acf8ec429&pid=1-s2.0-S0925857419304197-main.pdf
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a. Formula for elevation change limit of detection (LoD) when comparing two 
DSMs: LoDelev = t * √(RMSE of DSM12 + RMSE of DSM22) 

i. where t is the t distribution value at a desired level of confidence (i.e., at 
95% confidence, t = 1.96) and RMSE of DSM1 and DSM2 are the root 
mean squared errors of the pre- and post-excavation DSMs, respectively.   

43. Open the ‘workflow_elevation_database’ template or the experiment version if entering 
data from the manipulative experiment (\imagery_data_spreadsheets). Enter the 
required data in the ‘RMSE’ and ‘yint_slope values’ tabs based on outputs generated in 
above sections of the workflow. Column header definitions are defined in the 
‘metadata’ tab.  

a. Note, the data templates have an example from one reef in North Carolina. 
Delete this entry after entering your data and copying the formulas.  

b. In columns I and J of the ‘elevation limit of detection’ tab, re-enter the ‘best’ 
DSM adjustment determined in step 24 used for each DSM in the time series 
(e.g., pre- and post-excavation DSMs, respectively). For the experiment, where 
three DSMs were generated, enter the best DSM adjustment for the shell 
addition DSM in column K.  

c. In column K (or L for the experiment), enter a value of 1 for each row containing 
data. The 1 represents the t distribution value associated with 68% confidence. 

d. In column L (or M for the experiment), calculate elevation change LoD.  
i. The excel formula for calculating LoDelev for pre vs post excavation based 

on ‘best’ DSM using y-intercept and slope adjustment is: 
=$K3*SQRT(RMSE!M3^2+RMSE!P3^2). 

ii. Repeat the calculation, making sure to reference the correct RMSE based 
on the ‘best’ DSM adjustment for the remaining reefs in your dataset.  

iii. Note, for the experiment, an additional column of LoD calculations is 
necessary to account for the post-excavation vs shell addition DSMs. The 
format of the excel formula is the same as above with different RMSE’s 
referenced.  

e. In column N (or O and P for the experiment), convert LoD calculations to meters 
by dividing LoD values in column L (or columns M and N for the experiment) by 
100.  
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III. Oyster Reef Rugosity Workflow 
 
Workflow lead and contact: Gary Sundin (SundinG@dnr.sc.gov) 
 
Overview 

1. Introduction 
2. Prepare data 
3. Create lines from RTK data 
4. Combine rasters (optional) 
5. Add line surface information 
6. Calculate GIS line rugosity 
7. Create rugosity polygons 
8. Add polygon surface information 
9. Calculate polygon rugosity 
10. Data management and final output 

1. Introduction 
Rugosity is an index of surface roughness or complexity. Whether it’s a line or an area, rugosity 
refers to the surface deviation from a perfectly smooth form. 
 

1.1 Profile Rugosity (Line): 
When considering a line (or profile), simple rugosity is quantified as the ratio of the 
length of the real surface to the length of its ideal linear form. Larger values are 
relatively rougher than lower values, and a perfectly smooth surface has a simple 
rugosity value of “1”. 

 
1.2 Area Rugosity (Surface): 

For three-dimensional data, the rugosity of a surface is calculated as the ratio between 
the contoured surface area and the ideal planar area. 

 
Basic rugosity = L/D 

Where L = profile distance, and D = straight-line distance 
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This workflow explains how to use ground-based RTK point data and UAV-generated raster 
elevation data to calculate GIS-based rugosity values for lines and polygons. 
 
Input files needed: 

- Corrected DSM(s) for area(s) where rugosity data were collected 
- Table of RTK point data for endpoints of lines where field rugosity data were 

collected 
- Table of in situ rugosity results data and key metadata (xxx_raw_data_rugosity, 

where xxx = three letter reserve abbreviation) 
Data templates (.csv format) 

- xxx_raw_data_rugosity: base file with key metadata and field-based rugosity 
measurements for joining to final GIS output (this template has already been 
populated) (e.g., ace_raw_data_rugosity) 

- workflow_input_rtk_rugosity: point dataset of endpoints of lines where rugosity 
data were collected in the field 

- workflow_rugosity_database: final output containing key metadata, field-based 
rugosity results, and GIS-based rugosity results 

Note, all of these templates can be found at the following paths: \in-situ_data_spreadsheets 
or \imagery_data_spreadsheets 

2. Prepare data 
2.1 Determine Project Structure 
Prior to starting, decide whether all sampled reefs will be housed in the same ArcGIS 
project (e.g., each reef will have a separate Map tab), or if each ArcGIS project will 
house an individual reef. Note, your decision will affect the naming convention of the 
final exported ArcGIS project(s), specified at the end of the workflow. 
 
2.2 Tabular Data Structure 
Base data is line level data; each line is the line between a pair of RTK rugosity line 
endpoints. For this workflow each record must share a LineID value that matches a pair 
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of endpoints in the RTK point file. The example provided below is based upon the data 
template titled: xxx_raw_data_rugosity (e.g., ace_raw_data_rugosity). A copy of each 
Reserve’s data can be found at \in-situ_data_spreadsheets. The file contains key 
metadata as well as field-based rugosity results for each rugosity measurement. A 
column has also been added to this table with LineID values to be used in this workflow 
(reserve initials + RTK rugosity point names). Please download this template (already 
populated for all reserves) from \in-situ_data_spreadsheets. Be sure to use the unique 
LineID in this file throughout the workflow.  
 
This data structure will facilitate summaries or analyses among groups (e.g., sites, reef 
types, etc.) and between GIS and field-based methods.  

 

 
 

RTK data is point level data and should be structured in pairs, with each pair sharing a 
common identifier and representing the endpoints of a single line. Instructions are 
provided for starting with a .csv file containing LineID, PointID, easting, northing, and 
elevation data for each point. Note that the LineID is unique to each PAIR, where each 
pair represents the endpoints of the line where field-based rugosity was measured. 
Please use the same unique LineID that is found in the xxx_raw_data_rugosity template. 
The example provided below is based upon the data template titled: 
workflow_input_rtk_rugosity. This workflow assumes that a geodatabase (.gdb) has 
been created and will be used throughout the process. 
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2.3 Import Tables 
When the tabular data are in the correct format, import the tables into a geodatabase. 
If using an .xlsx (excel) file, copy the data to a new workbook and save as a .csv file.  
 
- Search for the “Table to Geodatabase” tool  
- For the “Input Table” field, add your RTK point data and (if using) 

xxx_raw_data_rugosity table. These can be imported singly or at the same time.  
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3. Create lines from RTK data 
 
3.1 Convert RTK data table to GIS data 
- Search for “XY Table to Point” tool 
- Input table = .csv rugosity file with RTK 

coordinates  
- Output feature class = converted file with 

coordinates displayed  
- X Field = “Easting” column with X 

coordinates in .csv 
- Y Field = “Northing” column with Y 

coordinates in .csv 
- Z field = “Elevation” column with Z 

coordinates in .csv 
- Coordinate system = click and drag (or select from dropdown menu) a 

DEM/ortho/other file with coordinate system of interest (e.g., NAD 1983 2011 UTM 
Zone xxN, NAVD88) 

 
 
3.2.A Automatic method (preferred). 
This method can be used if rugosity 
points are in pairs that have a 
common identifier as described in the 
Data Preparation section. If manual 
digitizing of lines is preferred, skip to 
2.2B for that alternative.  
 
- Search for the “Points to Line” tool 
- Input: RTK rugosity point file 
- Output: Line file to location of 

choice 
- Line Field: enter the common 

identifier field 
- Sort Field—can be left blank 
- Close line – leave unchecked 
- Line Construction Method: construct two-point line 
- Attribute source: none 
- Environments: Output has Z values: Enabled (not shown) 
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3.2.A.1 The “Points to Line” tool output contains only the LineID and several 
automatically generated fields. 
 
- With line feature attribute table open, use the “Add” button to add 4 fields for 

LineLength, LineRugosity, PolygonArea, and PolygonRugosity, each Double data 
types.  

- Save the changes. 
 

 
 

 
 

3.2.A.2 Right click on the “LineLength” field header and select “Calculate Field” 
 
- Leave “Input Table”, “Field Name”, and “Expression Type” as default. 
- To fill in the calculation field, double click on “Shape_Length” (surface length) under 

fields, and Apply 
- This step simply copies the auto-generated length field into a permanent location 

where it will not be altered in subsequent steps. 
- Close the calculate field dialogue box 
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3.2B Digitize lines from the points (if using Step2A, skip this step and proceed to Step 3) 
 
3.2.B.1 Create an empty line feature class in your geodatabase to digitize lines into 
 
- Right click on the geodatabase (ending in .gdb) and select New > Feature Class 
- Apply an appropriate name 
- Feature class type = ‘Line’  
- In Geometric Properties select to enable “Z values” and leave “Add output…” 

checked 
- Click Next 
- In “Fields” menu, add fields for LineID (Text), LineLength (Double), LineRugosity 

(Double), PolygonArea (Double), and PolyRugosity (Double) 
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- Click Next 
- Set the current horizontal (XY) and vertical (Z) 
- Click Next 
- Leave “Tolerance” and “Resolution” and “Storage Configuration” settings at default 
- Select “Finish” and blank line feature should automatically add to project  

  
3.2.B.2 Set or verify snapping tolerance 
 
- From “Edit” tab, in the snapping group, 

make sure snapping is turned on 
- Choose “Snapping Settings” and check 

that the general XY tolerance is set to 
something like 10 pixels 
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- Having snapping turned on will make it easy to select rugosity points to create the 
lines 

 
3.2.B.3 Digitize lines 
 
- It is a good idea to have the point feature containing the RTK point data and the 

blank line file both open so they can be viewed together (for example, stacked) 
 

 
 
 

- The blank line file must be turned on in the 
Contents pane. 

- On the “Edit” tab, in the “Features” group, 
select the “Create” option to open the “Create 
Features” panel 

- On the “Create Features” panel choose the 
rugosity line feature and the “Two-Point Line” 
tool  

- Use the Points file to identify and track the lines as you make them. You can double 
click on a point to center it in your view 

- Hover over a point to select it; after a circle appears around the point click to select; 
hover over the second point and repeat to complete a 2-point line. The line will 
appear in your line feature  
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- Manually type in the correct LineID, based on points used to create it 
 

 
 

- Periodically save your work by clicking the save icon on the “Edit” ribbon menu 
- Complete for all rugosity lines 

 

 
 

- When complete, make sure all edits are saved and all selections are cleared 
 

 
3.2.B.4 Populate the LineLength Field 
 
- Right click on the “LineLength” field header and select “Calculate Field” 
- Leave “Input Table”, “Field Name”, and “Expression Type” as default 
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- To fill in the calculation field, double click on “Shape_Length” (surface length) under 
Fields, and Apply 

- This step simply copies the auto-generated length field into a permanent location 
where it will not be altered in subsequent steps 

 

 
 

4. Combine rasters (optional) 
This method can be used to combine the DEMs from several sites so rugosity can be 
calculated for multiple sites at the same time. This can be skipped if rugosity is 
calculated separately for each site but is very convenient for calculating values across 
multiple sites. This method uses a raster function and will not change the individual 
rasters. 

 
4.1 Apply raster function 
 
- Add corrected rasters to your project 
- From the “Imagery” menu, choose “Raster Functions” to open raster function pane  
- From “Data Management” group, select “Merge Rasters” 
- In dialogue box, add rasters 
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- Leave Resolve Overlap set to “first” and Output Layer Type as “Raster Layer” 
- Select “Create New Layer” 
- The merged raster layer is added to the project 
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5. Add line surface information 
 

5.1 In Geoprocessing pane, search for “Add Surface Information” tool 
 
- Add rugosity line file as the Input Features 
- Add elevation raster for the Input Surface. This will be either for a single site or a 

combined raster for multiple sites. Example is for the merged raster described in 
optional step 3. 

- Select Surface Length 
- Leave Method default as Bilinear, and Noise Filtering blank   
- Sampling distance can remain blank to use the actual pixel cell size, or a value can be 

chosen. It is recommended, as in this example, that it is left blank, to use actual 
raster cell size. 

- Before running tool, clear any selections. If any records are selected in the line file, 
the tool will only calculate for that selected record. 

- A field called “SLength” will be added to the line file and populated with the surface 
length.  
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6. Calculate GIS line rugosity 
 
6.1 Recall: rugosity = L/D 

   
- In the line feature class attribute table, field names, L = “SLength” and D = 

“LineLength” (calculated in a previous steps) 
- In attribute table, right-click on the column heading for “LineRugosity” to highlight 

column and choose “Calculate Field” from the dialog box 
- In the calculate field dialog box leave the “Input Table” and “Field Name” and 

“Expression Type” as default.  
- Delete any pre-existing entries in the calculation field 
- To fill in the calculation field, double click on “SLength” (surface length) under fields, 

then select “/” (divide by), then double click “LineLength” (planar length).  
- Click “Apply” to calculate rugosity.  

 
 

 
 

7. Create rugosity polygons 
 
7.1 Create Buffer 



31 
 

- Make sure all edits are saved and all 
selections are cleared 

- In Geoprocessing Panel, search for “Buffer” 
tool. There are several options—be sure to 
choose the tool simply called “Buffer” (not 
Buffer 3D, Graphic Buffer, Create Buffer, 
etc.). 

- For input features, use the rugosity lines 
previously created. 

- Give the output a name/location 
- Enter 0.125 for the distance and select 

“Meters” as the “Linear Unit” 
- Set “Side Type” as Full, “End Type” as Flat, 

“Method’ as Planar and “Dissolve Type” as 
No Dissolve  

- Run tool 
- Result will be a new feature consisting of small rectangles around the rugosity lines 

and an attribute table containing all the previous fields PLUS additional fields 
including “Shape_Area”. 
 

7.2 Populate PolygonArea field 
 

- In the Buffer feature attribute table, save any edits and clear any selections 
- Right click on the “PolygonArea” field header and select “Calculate Field” 
- Leave “Input Table”, “Field Name”, and “Expression Type” as default 
- Delete any pre-existing entries in the calculation field 
- To fill in the calculation field, double click on “Shape_Area” (planar surface area) 

under fields, and Apply 
- This step simply copies the auto-generated length field into a permanent location 

where it will not be altered in subsequent steps 
- Close dialogue box 
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8. Add polygon surface information 
 
8.1 From Geoprocessing Pane, search for 

“Add Surface Information” tool. 
 

- Add rugosity buffer polygon file as the 
Input Features 

- Add elevation raster for the Input 
Surface. This will be either for a single 
site or combined raster for multiple 
sites. Example is for the merged raster 
described in optional step 3. 

- Select Surface Area 
- Leave Method default as Bilinear, and 

Noise Filtering blank   
- Sampling distance can remain blank to 

use the actual pixel cell size, or a value 
can be chosen. It is recommended, as 
in this example, that it is left blank, to 
use actual raster cell size. 

- Before running tool, clear any 
selections. If any records are selected in the polygon file, the tool will only calculate 
for that selected record. 
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- A field called “SArea” will be added to the polygon file and populated with the 
surface area 

 

9. Calculate polygon rugosity 
 

9.1 Save any edits and clear any selections 
 

- In polygon file attribute table, right-click on the column heading for 
“PolygonRugosity” to highlight column and choose “Calculate Field” from the dialog 
box. 

- In the calculate field dialog box leave the “Input Table” and “Field Name” and 
“Expression Type” as default. 

-  To fill in the calculation field, double click on “SArea” (profile surface area) under 
Fields, then select “/” (divide by), then double click “PolygonArea” (planar area).  

- Click “Apply” to calculate rugosity. 
 
 

 
 

10. Data management and final output 
 
10.1 Joining tables 
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- Save any edits and clear any selections. 
- Make sure xxx_raw_data_rugosity is available in the geodatabase (imported Step 

1.1) and add to project so it is visible in Contents pane. 
- Right click on the file in the Contents Pane, select “Joins and Relates” and “Add Join” 

 

 
 

- On the join dialog box, as the Join Table, select the results table which is the Polygon 
buffer created in the steps above. 

- Select “LineID” as the input join field and the same field should automatically 
populate for the join table. 

- Choose “Index Joined Fields”. 
- It is a good idea to “Validate Join” which will create a message indicating if there are 

any errors. If not, close this message. 
- Select “OK”. 
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10.2 Exporting tables 
 
- Input is the joined table created in the previous 

step. 
- Search for “Table to Excel” tool. 
- For “Input Table” select the results table 
- Check the “Use field alias as column header” box to simplify field headers (optional) 
- Choose a location and run tool 
- An excel spreadsheet is created 
- Alternatively, the table can be selected and copied directly to a spreadsheet 
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10.3 Final data manipulation 
 
- If the workflow_input_rtk_rugosity template and the xxx_raw_data_rugosity 

template were used to configure data for the previous steps, then the output data 
will be easy to configure for entry into the workflow_rugosity_database 
spreadsheet. 
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- The following column headings from the Base table should not change and can be 
copied directly into the results template 

o Site 
o Reef_coord_northing 
o Reef_coord_easting 
o Date 
o Reef_name 
o Reef_abbreviation 
o Reef_type 
o Harvest_status 
o Project_name 
o FieldRugosity_level 
o FieldRugosity_slope 

 
- The following column headers in the output table (left) can be copied into the 

corresponding results template (right) as shown below 
o LineLength    = GIS_Planar_LineLength 
o SLength    = GIS_LineProfile_length 
o LineRugosity  = GIS_LineRugosity 
o PolygonArea  = GIS_Planar_PolygonArea 
o Sarea   = GIS_3D_Area 
o PolygonRugosity  = GIS_PolygonRugosity 

 
- Alternatively, the output table can be modified by removing the non-used headers 

(e.g. OBJECTID, LineID, Shape_Length, Shape_Area, etc.), and renaming, adding, and 
relocating the appropriate columns as needed. 

 
10.4 Exporting ArcGIS project (.ppkx) 
- Exported rugosity projects are located at the following path: 

\imagery_analysis_arcgis_packages\xxx\rugosity (where xxx = reserve initials) 
- Share tab → Project (left side) 

o Start packaging = “Save package to file” 
o Item details = change the file location and name, as appropriate 
o Select the checkbox for “Share outside of organization”. Make sure all other 

checkboxes are unselected 
If the projects are reef-specific, save the files as: 
xxx_zz_mmddyy_rugosity.ppkx, where xxx = reserve initials, zz = reef 
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initials, mmddyy = date sampled (e.g., 
noc_nr_061323_rugosity.ppkx). 
 
If the projects are workflow-specific, and contain all reefs, save the 
file as: xxx_allreefs_yyyy_rugosity.ppkx, where xxx = reserve initials, 
yyyy = year sampled (e.g., noc_allreefs_2023_rugosity.ppkx). 
 
For the experimental reefs, save the files in one of the two formats 
listed above, and add ‘_experiment.ppkx’ at the end of the name 
(e.g., noc_nr_030724_rugosity_experiment.ppkx). 
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IV. Oyster Reef Footprint Classification and 
Assessment Workflow 
 
Workflow lead and contact: Dan Bowling (djbowlin@ncsu.edu) 

 
Figure 1. Workflow of Supervised Classification for oyster reef footprint. 
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Overview 
1. Determine project structure 
2. Start up (GIS Basics) 
3. Heads-up delineation (Traditional approach 1) 
4. Heads-up grid classification (Traditional approach 2, optional) 
5. Machine learning, supervised classification 
6. Accuracy assessment 
7. Classification to footprint 
8. Areal footprint compare 
9. Assessing delineated footprint boundary accuracy 
10. Sharing and uploading projects 
11. Appendices 
12. Digital reef classification & footprint assessment cliff notes 

1. Determine Project Structure 
Prior to starting, decide whether all sampled reefs will be housed in the same ArcGIS project 
(e.g., each reef will have a separate Map tab), or if each ArcGIS project will house an individual 
reef. Note, your decision will affect the naming convention of the final exported ArcGIS 
project(s) specified at the end of the workflow. 

2. Start Up (GIS Basics) 
Create a project folder to house your project, associated files, and ArcGIS Pro database 

▪ This is a good time to create a “Data Inputs” folder and add copies of the original 
study site orthomosaics, corrected DEMs/DSMs (hereafter referred to as DSMs), and 
other associated layers/files (these can later be moved into a geodatabase as 
preferred). See Appendix 1.0 for further information on creating an ArcGIS 
Geodatabase. 

 

Open ArcGIS Pro and create new project, referencing project folder (Appendix 1.0) 
Click Add Data and add all project layers. 

Minimum Data Requirement: Study site RGB orthomosaic 
Data for Improved Results: Corrected DSMs of good quality, RTK boundary delineated 
reef footprints are recommended to improve raster classification accuracy.  
Optional Data: Multispectral, NDVI, texture/roughness raster layers (e.g., Vector 
Ruggedness Measures, Terrain Ruggedness Index; see Oyster Percent Cover and Oyster 
Density workflow sections for details on creating these layers), or layers from previous 
surveys for comparison. 
▪ Select YES to build pyramids and calculate statistics for all layers if requested. 
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Corrected and quality DSMs are recommended for each project, follow step-by-step guide in 
Oyster Reef Elevation and Elevation Change Workflow. [Optional: RTK GCP and Checkpoint 
points can be added to verify layer accuracy and that the project is working with the corrected 
DSM. This can be done by adding a the RTK.csv file, right clicking on the newly added table in 
the Contents pane, select “Create Points From Table”, click “XY Table To Point”, enter an 
appropriate name for RTK data, set X to Easting, Y to Northing, and Z to Elevation (this can be 
checked for accuracy by selecting the table and opening from the Contents pane). Make sure 
the coordinate system matches the ortho! Once added, make sure the points are properly 
aligned with GCPs and Checkpoints and the DMS with the ortho.] 
 
 
Add in situ RTK collected footprint points as .csv file (again check coordinate system) 

▪ Add .csv file 
▪ Right click on .csv data in the Contents pane 
▪ Select “Create Points From Table” 
▪ Click “XY Table To Point” 
▪ Enter an appropriate name for RTK data, set X to Easting, Y to Northing, and Z to 

Elevation 
▪ These points will be used later to create an in-situ reef ecotone layer (or multiple 

layers if field sampling delineated reef-water ecotone/boundary, subtidal shell extent 
ecotone/boundary, marsh ecotone/boundary, etc.). [If this was not done in the field, 
there will be the option to do this digitally during the workflow] 

▪ Be sure to hide this layer during Heads-Up Delineation to avoid biasing results. 
 
Fill database fields A-I for Site Information in the workflow_footprint_database available at 
the following path: \imagery_data_spreadsheets 

 
2.1 – Set Site Boundary 
Next all layers will be clipped to the Site Boundary Layer to help standardize outputs and 
analysis (this is also a good time to see if future flight paths, or GCP placement needs to be 
adjusted). 
Site boundaries can be set based on the needs of each End User. For example, if priorities are to 
monitor several strata (e.g., reef, marsh, mud flat, submerged aquatic vegetation, etc.) or at a 
broader landscape scale it may be beneficial to just clip the margins of the aerial data (Option 1, 
Figure 2). Be aware, however, that larger sites may produce lower classification accuracies and 
kappa values due to confusion from additional strata (classes in your machine learning schema), 
strata with similar spectral characteristics, water confusion and glare, and image artifacts. 
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End Users most interested in one stratum (i.e., Oyster Reefs) and willing to accept the tradeoff 
of reduced map area for higher classification accuracy and kappa values should opt to set a 
smaller and more selective site boundary (Option 2, Figure 3). This approach may better serve 
those using study sites as indices or proxies for reef “condition”. 
 
Option 1.   Analysis � Tools � Create Feature Class (Data Management Tools) 

 Feature Class Location: Select project geodatabase 
 Feature Class Name: Site_Boundary_Layer 
 Geometry Type: Polygon 
 Coordinate System: Set to site ortho layer 
 *Leave remaining options as default 
 *Click Run 

*On the ribbon, click Edit, Create icon, select Site_Boundary_Layer and 
preferred drawing tool and create a feature to represent the site boundary 
*Once created, this feature can be modified by clicking the Modify icon on the 
ribbon 
*Click Save under the Edit tab once finished with edits. 

Click the Geoprocessing tab or analysis tab on the ribbon, then Tools. Search Clip Raster (Data 
Management Tools). [Note: This will clip to whatever shape you created for your site boundary. 
If you are wanting a closer or irregular shape boundary, skip to option 2 below.] 
   Input Raster: Select each input layer (i.e., ortho, DSM of the site) 

[Note: This can be the color-balanced ortho or a raw reflectance 
map, depending on available outputs] 

   Output Extent: Boundary_Layer 
Output Raster Dataset: “Name_of_layer”_Clip (be sure to check output 

locations are within geodatabase) 
Check “Use Input Features for Clipping Geometry” 
NoData Value: 255 (This could also be 256 in some versions, or a 

completely different value for DSMs/additional layers. This can be 
checked via a data query in the null data region in the map 
frame.) 

*Click Run 
*Repeat with all data input layers (i.e., DSM, etc.) for standardization of the 
study area and assessment 
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Figure 2a, b. Raw study site orthomosaic raster and created study site boundary areas (left 
panel) and the resulting clipped layer, allowing for spatiotemporal standardization of each 
study area (right panel).  
 
Option 2. More closely delineates the oyster reef using the same steps in option 1 above and 
selecting a more appropriate drawing tool for quick delineation (Polygon, Lasso, or Freehand 
Line). Others may prefer the flexibility offered by using the Add Graphics Layer tool. 
This close boundary delineation approach can be quick and crude for efficiency as the 
supervised learning steps will more accurately define the oyster reef footprint. For best 
classification results, be sure to remove excess water and habitat areas not needed in oyster 
reef classification. Be mindful to include some degree of buffer, capturing areas that may serve 
as future oyster habitat as reefs recruit, expand, or migrate. The initial area defined as the site 
boundary should be saved and applied to all future surveys for spatiotemporal standardization 
in analysis. 
 

Use Create Feature Class as above in Option 1 or use: 
Map tab � Add Graphics Layer 
*A graphics layer will be added to your Map Contents panel 
*Select in Contents panel, Click Graphics tab and in the Insert group chose a 
feature drawing tool (Polygon, Lasso, or Freehand Line is recommended) [Note: 
If Lasso or Freehand Line is used, the Feature to Polygon tool will need to be 
used prior to applying a mask for the intended area. Also, fill color for the 
Polygon drawing tool can be changed to No Fill to assist.] 

 
*Once drawn, Tool � Graphics to Feature (Conversion Tools) can be used 
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 Input Graphics: Select Graphics Layer 
 Graphics Type: Select Polygon 

Output Feature Class: Navigate to project geodatabase and name 
Boundary_Layer 

Analysis � Tools � Graphics to Features (Conversion Tools) 

 
*Note: If you are creating a polygon around separate patch reefs, make sure 

they are connected with a thin line between them; disconnected 
polygons may pose problems later in the workflow. 

Analysis � Tools � Extract by Mask 
 Input raster: Select site data layers (Ortho, DSM, etc.) 
 Input raster or feature mask: Select newly created graphics feature 
 Output raster: Name appropriately and save for future use 

[NC_MiddleMarsh_ortho_bound] 
 Extraction Area: Inside 

(This method will reduce the negative space and null data areas in 
subsequent data layers) 

  
Figure 3a, b. Raw study site orthomosaic raster and created study site boundary areas (left 
panel) and the resulting clipped layer, allowing for spatiotemporal standardization of each 
study area (right panel). 
 
Fill workflow_footprint_database fields J-L for Boundary Information (Clipped_Y/N, 
Boundary_Size) 
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2.2 – Stretch Raster 
Select the clipped raster ortho layer from the Contents. 
Click the Raster Layer tab on the ribbon and select the Stretch Type icon. 
 Stretch Type: Percent Clip 
 Min: 2.0 
 Max: 2.0 

 
 
 
Under the Enhancement tab, adjust Layer Brightness, Layer Contrast, and Gamma (adjust last 
and only if needed, typical value for gamma should be 0.7-1.8 to achieve good white balance). 

▪ The goal should be to make the oyster reef/shell areas as prominent as possible. 
▪ Tip: The standardized balance that was found to best accentuate reefs was brightness 

10, contrast 10, gamma 1.0, however this will strongly depend and vary based on 
initial image products and environmental conditions during surveying. 

(Note: Raster stretching tools can also be accessed via the layer’s symbology - right click the 
raster layer on the contents pane � select “symbology” � set the min and max below. More info 
on the Stretch Raster Function can be found at: 
https://desktop.arcgis.com/en/arcmap/latest/manage-data/raster-and-images/stretch-
function.htm ) 

https://desktop.arcgis.com/en/arcmap/latest/manage-data/raster-and-images/stretch-function.htm
https://desktop.arcgis.com/en/arcmap/latest/manage-data/raster-and-images/stretch-function.htm
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Fill workflow_footprint_database fields M-T (Raster Enhancement notes and 
StartUp_Time_min) and make sure fields A-T are entered. 
 
2.3 – RTK In-situ Delineation 
In this step RTK data that was collected in the field will be used to create an in-situ reef ecotone 
layer (or multiple layers for reef-water boundary, subtidal shell extent boundary, marsh 
boundary, etc.). Toggle on the site ortho and overlay this layer with the RTK point layer. Use the 
select tool to select all the points of each desired category (the Shift key can be held down to 
add to selection and the Control key can be used to remove points from selection). Separate 
reef areas and patch reefs will need to be broken down into sub-reef areas and run through the 
following steps. 
Once all points are selected for a boundary type, right click the RTK layer in the Contents pane � 
Selection � Make Layer From Selected Features 
Use the Points to Line tool with the RTK collected data on footprint from the field. 
  Line Field: leave blank 
  Sort Field: leave blank 

Select “Closed Line Option” 
Select “Construct Continuous Line” 

  *Click Run 
 Next use the Feature to Polygon tool 
  Input: previous output 
  Name output appropriately to signify this is the RTK footprint of the study site 
  *Click Run 
Optional: The Merge tool can be used to combine polygon layers. 
 
Note: If there are points missing in areas, use the Create New Feature tool, followed by Merge 
tool to fill in data gaps. Similarly, if the following steps do not generate an accurate layer, some 
points may need to be de-select for clarity or the RTK points can simply be used as a guide to 
create an accurate layer using the Create New Feature tool. 
 
2.4. RTK Delineated Metrics 
Right click on the created footprint feature in the Contents pane and open the feature’s 
attribute table. Click “Add” next to Field: just above the attribute table, enter Shape_Perimeter 
for Field Name and Alias, set Data Type to Double and Number Format to Numeric. Click the 
Save icon on the ribbon (repeat this process for Shape_Area if it does not already exist). To 
calculate the parameter, right click on the column heading, and select “Calculate Geometry”. 
 Field: Shape_Perimeter  

Property: Perimeter length (geodesic) 
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 Length Unit: Meters 
 Coordinate System: Select the same as the ortho 
 *Click “Ok” 
 *For large areas, be sure that the Shape_Area is using the Area (geodesic) 
  
Values of Interest: 
 Footprint area: Found in Field Shape_Area 
 Footprint perimeter: Found in Shape_Perimeter 
  
Fill workflow_footprint_database fields U-W (RTK Delineation). 

3. Heads-Up Delineation (Traditional Approach 1) 
This section will focus on creating a footprint layer from the study site orthomosaic using a 
heads-up or on-screen digitizing approach to trace the reef footprint. Prior to machine learning 
tools, this approach was a traditional standard for extracting area and perimeter estimates and 
it will serve as a comparative metric for future machine learning classification results. At sites 
where in-situ RTK delineation was not collected, this step would be recommended. 
To get started, navigate to the toolbox to create a new feature class in your geodatabase that 
we will use to create a digital delineation of the reef footprint. This can also be accomplished 
using the Add New Graphics tool and initial steps listed above in create boundary option 2 
(section 1.1). Users should consider delineating total footprint (including what is invisible in 
water), exposed footprint, or both as separate features. 

Analysis � Tools � Create Feature Class (Data Management Tools) 
 Feature Class Location: Select project geodatabase 
 Feature Class Name: [Site ID]_HU_Delin_[User Initials] 
 Geometry Type: Polygon 
 Coordinate System: Set to site ortho layer 
 *Leave remaining options as default 
 *Click Run 

*On the ribbon, click Edit, Create icon, select the newly created feature in the 
Create Features pane and preferred drawing tool (polygon recommended) and 
create a feature to represent the site boundary 

*Click along the perimeter edge of the reefs, keeping each point around 
one meter or less apart to standardize the approach and match the 
resolution of in-situ RTK data 
*Vertices can be deleted by hovering the cursor over a point until it 
changes appearance, right clicking, and selecting delete 
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*Click  to finish and click the Save button the top of the ribbon when 
complete 
*Large, shell devoid areas can be cut out from larger footprint by creating 
a separate feature for these areas and using the clip tool to remove them 
from the larger footprint. 

*Once created, this feature can be modified by clicking the Modify icon on the 
ribbon 

Delineated Metrics 
Right click on the created footprint feature in the Contents pane and open the feature’s 
attribute table. Click “Add” next to Field: just above the attribute table, enter Shape_Perimeter 
for Field Name and Alias, set Data Type to Double and Number Format to Numeric. Click the 
Save icon on the ribbon (repeat this process for Shape_Area if it does not already exist). To 
calculate the parameter, right click on the column heading, and select “Calculate Geometry”. 
 Field: Shape_Perimeter  

Property: Perimeter length (geodesic) 
 Length Unit: Meters 
 Coordinate System: Select the same as the ortho 
 *Click “Ok” 
 *For large areas, be sure that the Shape_Area is using the Area (geodesic) 
  
Values of Interest: 
 Footprint area: Found in Field Shape_Area 
 Footprint perimeter: Found in Shape_Perimeter 
 
Fill workflow_footprint_database fields X-Z (Heads-Up Delineation). 
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Figure 4. Town Marsh Lagoon, 2022 – Heads Up, linear delineated footprint 

 
Alternative Delineation Method (Optional): 
Use Spatial Analyst Raster Reclassify geoprocessing tool. 
Change to Integer Type 
Use Raster to Polygon tool 
Perimeter/boundary created 
Reference: How To: Create Polygons from a Raster Dataset Based on the Reclassified Value 
(esri.com) 

4. Heads-Up Grid Classification (Traditional Approach 2, Optional) 
Heads-up grid classification is an optional on-screen digitizing method that provides a more 
standardized and higher resolution and accuracy of reef footprint and reef level percent cover. 
To get started, in the Contents pane toggle on the orthomosaic layer and overlay the Boundary 
Layer. Under the Map tab on the ribbon, use the Measure Icon to measure the latitude and 
longitude distance (m) of the Boundary Layer (if the site Boundary Layer is not rectangular, a 
new rectangular graphic layer will need to be created, or the extent can be used of that 
feature). Note these measurements and zoom into the corner points to be as accurate as 
possible. Note down the measurements as these will be used in the next tool. 

https://support.esri.com/en-us/knowledge-base/how-to-create-polygons-from-a-raster-dataset-based-on-t-000030390
https://support.esri.com/en-us/knowledge-base/how-to-create-polygons-from-a-raster-dataset-based-on-t-000030390
https://support.esri.com/en-us/knowledge-base/how-to-create-polygons-from-a-raster-dataset-based-on-t-000030390
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▪ Search Toolbox for Create Fishnet tool 
  Output Feature Class: “sitename_year_grid” (save to correct geodatabase) 

Template Extent: Boundary_Layer (or Graphics Layer if a new one was used, this 
should be the same clipped study site) 

  Number of Rows: number will be Lat. distance/.25 (round to nearest whole) 
  Number of Columns: number will be Long. distance/.25 (round to nearest whole) 
  Uncheck Create Label Points 
  Geometry Type: Polygon 

▪ Leave all remaining fields blank 
▪ This will produce a grid with 0.0625 m2 cells (if a lower resolution is desired 

the number used to divide the distances accordingly; for example, a 
denominator of 1 will produce a grid with 1 m2 cells) 

-Select the grid output in the Contents pane, select Feature Layer tab on the ribbon, adjust the 
Transparency to user preference and Layer Blend to Color Dodge (or preference) to allow easy 
viewing of the ortho and a faint hint of the grid. 
-With the grid layer still selected in the Contents pane click the Map tab, then Select icon (chose 
selection method of choice – Lasso recommended). 
-Begin selecting grid cells that contain 50% or more of shell, by left clicking while holding down 
shift. Areas can continue to be added as long as the Shift key is held. Areas can be unselected 
by holding down the Ctrl key and left clicking. Important, be sure to save progress often in case 
selection is lost. Reopening a save point will restore selected areas. 
-Once a significant area of shell has been selected, an interim layer can be made by right 
clicking on the grid layer in the Contents pane, going to Selection � Create Layer From Selected 
Features. 
-Symbology of layer selections can be adjusted (i.e., with a fill color) to assist in continued 
delineation and classification. 
-Once the study site has been fully classified, any selected layers can be combined into a single 
layer using the Merge tool (Data Management Tools; Merge (Data Management)—ArcGIS Pro | 
Documentation). 
 
Optional: If time is a limiting factor for creating this footprint layer from scratch, use RTK 
polygon or heads up delineated polygon of the footprint to guide selection and extract exact 
area of interest from fishnet. (Map tab � Select by location � Apply, then export selections to 
obtain only targeted reef area grids, finally tabulate using these new layers). ***Be aware that 
this shortcut does have strong potential to bias the layer and overestimate footprint. Time is 
still needed to go back through and de-select grids that were incorrectly selected.*** 
 

https://pro.arcgis.com/en/pro-app/3.1/tool-reference/data-management/merge.htm
https://pro.arcgis.com/en/pro-app/3.1/tool-reference/data-management/merge.htm
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Figure 5a, b. Town Marsh Lagoon, 2022 – Grided (0.25m x 0.25m) footprint area (5a is zoomed 
in to show the process of selecting the individual grids in order to create the layer for oyster 
reef footprint seen in 5b). 
 
Grid Classification Metrics 
Currently, the classified grid layer of the footprint consists of hundreds to thousands of unique 
polyshape files and these need to be combined. 
 
Dissolve Polygon Features to make Simplified Polygon Feature Layer 
Analysis Tab � Tools � Dissolve (Data Management Tools) 
 
 Input Features: select gridded footprint layer 
 Output Feature Class: name final footprint layer (ex. “MM23_Grid_Footprint_DB”) 
 Check “Create multipart features” only 
 * Click Run 
 
Right click on the created final footprint feature in the Contents pane and open the feature’s 
attribute table. Click “Add” next to Field: just above the attribute table, enter Shape_Perimeter 
for Field Name and Alias, set Data Type to Double and Number Format to Numeric. Click the 
Save icon on the ribbon (repeat this process for Shape_Area if it does not already exist). To 
calculate the parameter, right click on the column heading, and select “Calculate Geometry”. 
 Field: Shape_Perimeter  

Property: Perimeter length (geodesic) 
 Length Unit: Meters 
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 Coordinate System: Select the same as the ortho 
 *Click “Ok” 
 *For large areas, be sure that the Shape_Area is using the Area (geodesic) 
  
Values of Interest: 
 Footprint area: Found in Field Shape_Area 
 Footprint perimeter: Found in Shape_Perimeter 
  
Fill workflow_footprint_database fields AA-AC (Grid Classification). 

5. Machine Learning, Supervised Classification 
5.1 – Segmentation 
Select your stretched orthomosaic layer (created in section 1.2), click the Imagery tab on the 
ribbon, click the Classification Tools icon, and select Segmentation. Segmentation parameter 
selection is recommended as one of the following (Figure 6). 
 

   
Figure 6a, b. Two optional parameter setting combinations that have been tested and should 
be considered based on the resolution/image quality of the RGB raster. Higher resolutions and 
quality orthomosaics should have more confidence in selecting option 1 (Figure 6a). When finer 
spatial detail can be used, it can promote accuracy of the machine learning algorithms. In cases 
of fuzzy clarity or a high degree of spectral variation within a class or objects of interest, the 
extra detail is unhelpful and can result in more inaccuracies. In these instances, option 2 (Figure 
6b) with a higher spatial detail spec should be preferred. Option 2 will also help mitigate cases 
of glare and wave confusion when there is the possibility of such a challenge. 
 
  Spectral detail: 20.00 
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  Spatial detail: 0 (Other versions may have to select 1 here) 
Minimum segment size in pixels: 15 (Again, this depends on your layer 

resolution, adjust accordingly and further experimentation is welcome. 
For instance, a larger setting of 20, 30, or more may be helpful to combat 
glare and a high degree of color variation in shell areas.) 

Output Dataset: (adjust to meaningful name, example: 
“middlemarsh_06_23_ortho_segment”) 

* Click ‘Run’ 
 
Fill workflow_footprint_database fields AD-AI for Segmentation (Spectral_Detail, 
Spatial_Detail, Min_Seg_Size, Time) 
 
5.1.1 – Troubleshooting 
The segmented raster output will also contain an 
‘interindex.tif’ file. The index file contains the segmented 
raster information with associated attribute table. Keep the 
segmented raster and index raster files together. If they are 
separated, then any future use of the raster will produce a 
geoprocessing error due to a broken path.  
 
 
 
 
5.2 – Training Samples 
Select segmented layer in the Contents pane, click Imagery tab on the ribbon, click 
Classification Tools, scroll down to select Training Samples Manager. 
In the GIS project folder create a new folder (“Training_Data”) 
Download and add OysterFootprint_SCHEMA.ecs to the folder or create a unique project 
schema (Appendix 3.0). Add schema to Image Classification Training Samples Manager by 
clicking the down arrow next to the file folder and browse to the existing schema. Locate .ecs 
file within the project folder and add. 
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Schema can be adjusted, or new class/sub-class added, by right clicking on the level needed 
within the schema and selecting “Add New Class”: 
Unique values must be set for the Value field. At a minimum, we will classify OYSTER SHELL, 
WATER, and SEDIMENT. Feel free to add additional classes and subclasses as needed and 
desired for your specific sites. In the OysterFootprint_SCHEMA.ecs file the Current Name and 
Values included are: 

 Oyster Shell: 1 
  Submerged Oyster Shell: 2 
  Vegetated Oyster Shell: 3 
  Exposed Dark/Wet Oyster Shell: 4 
  Exposed Light/Dry Oyster Shell: 5 
  Shell Rake: 6 
 Water: 10 
 SAV: 20 
 Sediment: 30 
  Submerged Sediment: 35 
 Marsh: 40 
 
Schema Defined: 
Oyster Shell (parent class) – all detected and exposed oyster shell, both live oyster and 
dead oyster as substrate. Subclasses include Submerged Oyster Shell (shell has a 
different spectral characteristic due to submergence in water at time image acquisition), 
Vegetated Oyster Shell (shell with algal growth that may otherwise be miss-classified), 
Exposed Dark/Wet Oyster Shell (shell that is has not been exposed as long at time of 
image acquisition and therefore bearing a darker spectral characteristic; also typically 
more indicative of live oysters as they retain water in doing so have a darker relative 
signature), Exposed Light/Dry Oyster Shell (shell that is still intertidal, but has been 
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exposed long enough to bear a lighter signature; dead shell tends to dry faster than live 
individuals so this may warrant and additional sub-class if interested in teasing out live 
oysters here), Shell Rake (dead and typically mounded shell that appear bleach white 
due to extended sun exposure; these areas are not available to juvenile oysters as 
settlement substrate). 
Water (parent class) – any submerged area where the bottom remains undefinable 
without certainty or likely to be misclassified by machine learning. If water is present 
across a broad spectral range, consider creating sub-class if numerous samples of each 
area produce poor results and clipping the water extent is not preferred. 
SAV (parent class) – submerged aquatic vegetation (e.g., sea grass) 
Sediment (parent class) – exposed sediment at the study site at the time of survey. 
Subclass included submerged sediment as it typically appears spectrally different from 
exposed sediment. As the case with Water, add additional subclasses for sediment, 
especially exposed as needed. For example, mud will appear different from sand. 
Marsh (parent class) – marsh grass areas 
 

(These unique values were selected to standardize the approach across sites. Parent class 
level strata were staggered by ~10 units to allow for the addition of sub-class schema where 
warranted. Remember classes should exist to help the computer correctly classify. For 
instance, water may be used best to represent deep areas or muddy water areas where the 
bottom is not clearly depicted and shallow water areas where the bottom can be seen, 
reserved for submerged sediment classification. Establishing and following a clear definition 
for each is important both in training sample creation and again later in Accuracy 

Assessment.)  
 
Figure 7 – Example of a study site 
where it would be beneficial to collect 
training samples for both Exposed 
Dark/Wet Oyster Shell (orange 
delineated area) and Exposed 
Light/Dry Oyster Shell (purple 
delineated area). This is also a case 
where water with waves and glare can 
be better classified by including larger 
training samples (such as blue 
quadrat) to include glare and wave 
spectral and segment characteristics. 
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Remove any unneeded classes based on the study site, select save as to save schema changes 
to a new file name (i.e., keep the original version unmodified). 
Begin training sample selection by clicking on class of interest and then desired drawing tool 
(rectangle or polygon is recommended). 

▪ Take the time to collect quality training samples for each class, make sure to collect 
samples from different areas, of various sizes and dimensions (i.e., not just 
rectangles), and cover the spectral diversity of each class. Also be sure to grab 
samples from various elevations when relevant (see Appendix 3 for additional 
information). 

▪ Zoom in and out with the mouse wheel and hold down ‘c’ key to move 
around/pan the map while searching for locations to create new training 
samples. 

▪ Additional suggestions: Shell and Sediment samples should be mainly small 
and spectrally ‘pure’ samples, but some added benefit can be gained by 
including a few slightly larger (still relatively ‘pure’) samples to include 
segmentation node details as features to guide classifications. Water with 
lots of glare or waves/ripples can be best dealt with using larger samples 
that include glare and wave features. 

▪ The number of samples needed for each class will depend on the spectral variation 
expressed in each class and within each ortho/segmented layer. (Recommendation: 
for prevalent and varied classes aim for a minimum of 20 samples) 

▪ It is recommended to toggle on/off the segment layer to use the ortho to assist with 
placing training sample polygons for improved quality of training material. 

▪ Samples should be as targeted as possible and poor samples should be removed using 

the  icon. 
▪ If desired, stable areas can be targeted to use the same training sample polygon areas 

across orthomosaic/segmented raster layers for multiple time periods to improve 
efficiency (If using sample polygon locations from another time period, be sure to 
check the validity of the polygon placement to ensure quality training data).  

▪ Save training samples as a shapefile (this can be used for other surveys at this site) 
▪ Merge all samples into like classes by selecting each sample and clicking the merge 

icon . Samples can be unmerged by clicking . 
▪ Once merged, it is a good idea to check that sample collection number and percent 

distribution is representative of the general percent cover of each class (i.e., strata) 
within the site boundary. 

▪ Save final training samples within the project folder (Recommended to create a 
Training_Data folder to house all of the unique training files). 
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5.3 – Train Classifier 
Search Tools for Train Random Trees Classifier (Spatial Analyst Tools) and select: 
  Input Raster: Clipped and segmented ortho layer 
  Input Training Sample File: Select saved polygon training sample shapefile 
  Leave Dimension Value Field Blank 
  Output Classifier Definition File: sitename_year_segment_RT.ecd 

 (Note: This Must be saved in the project’s training folder and not in the 
geodatabase) 

Additional Input Raster: Select corresponding DSM or ortho if DSM does not 
produce good results (Note: if available, you could also use any of the 
Multispectral, NDVI, Texture rasters)  

(Important: If using the DSM in the classifier, it must be used in the 
classification of the raster and vice versa to avoid an error. It is also 
recommended to make a note of any additional layer used by referencing 
it in the output naming scheme. Using DSM as an additional raster layer 
can deliver slightly better classification results, but this appears to be 
dependent on the quality of the DSM and the lack of 
artifacts/inaccuracies. It is possible to apply a DSM from a previous 
sample period if it is still relevant to the imagery being analyzed). 

  Max Number of Trees: 50 
  Max Tree Depth: 30 

Max Number of Samples: 0 (Setting to 0 should allow for the algorithm to use as 
many as deemed necessary; if issues result then use default) 

  Segment Attributes: Select All 
▪ Click Run 

Search Tools Classify Raster (Spatial Analysis Tools) and select: 
  Input Raster: Select corresponding segmented layer 
  Input Classifier Definition File: Use output from Train Classifier tool 

Output Classified Raster: sitename_year_classified (Recommended to save in 
training data folder) 
Additional Input Raster: DSM/RGB/Multispectral layer (optional - if used note it 
in the naming scheme of the output classified raster) 
▪ Use of quality DSM typically improves classification accuracy, if multiple 

accurate DSMs exist for a site, select the one with the fewest artifacts (even 
layers from previous years could be applied). 

▪ Click Run 
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Inspect classified raster output. If the classification seems reasonable, move on to accuracy 
assessment. If the classification seems unreasonable, move to section 4.3.1 below. 
In cases where the resulting classes, or sub-classes, are not of interest in the final map product, 
the Merge Classes tool should be used to simplify the map layer.  
 Click Imagery Tab → Classification Tools → Merge Classes 
 Under Classification Schema navigate to your .ecs file and load. 

Under the New Class column new drop-down options should be available to select 
alternative classes to merge the old classes into new designations. Save output dataset 
with ‘merged’ somewhere in the file name. 
*Click Run 
 

Fill workflow_footprint_database fields AJ-AX for Training and Classifying. Actual processing 
times can be obtained in the View � Geoprocessing, under Recent, hold cursor over a used 
tool and click Open History. 
 
 
  

 
Figure 8a, b. Town Marsh Lagoon study site within the Rachel Carson Reserve displayed in an 
orthomosaic layer (UAS aerial imagery obtained from Drone the Oyster Science Collaborative; 
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top) and the resulting classified layer using current Machine Learning model with a Random 
Trees classifier (bottom).  
 
5.3.1 – Troubleshooting 
1. If DSM or additional layer was used and inaccuracies are falling around artifacts in those 
layers (a typically case is in DSMs where the corresponding ortho contains a lot of water glare), 
the Classify Raster tool can be re-run with only the RGB and segmented raster layer (often with 
good performance). 
2. Alternatively, Support Vector Machine can be utilized as a classifier (this can take longer for 
larger sites, but yield improvements when Random Tree fails) 

▪ Search tools for Train Support Vector Machine (Spatial Analysis Tools) and select: 
  Input Raster: Clipped and segmented ortho layer 
  Input Training Sample File: Select saved polygon training sample shapefile 
  Output Classifier Definition File: Sitename_year_SVM 

Additional Input Raster: Select corresponding RBG/ DSM/Multispectral layer 
(Optional - if used note it in the naming scheme of the output classified raster)  
Max Number of Samples: 0 

  Segment Attributes: Select All 
▪ Click Run 

3. Should classification remain insufficient, investigate where the output is failing and return to 
the Training Sample Manager to adjust polygon samples (look for some that may be poor and 
driving confusion) and add additional training samples to specific classes and map areas that 
are underperforming. 
4. If classification is still insufficient and there is an abundance of glare in the water, try 
reducing the size of the Site Boundary (created at the beginning of the workflow) to clip out as 
much water as possible. 

6. Accuracy Assessment 
Before you start the Accuracy Assessment, inspect the classified output layer to see if any 
negative area, null data, or extraneous classified area was created during the classification 
process. If so, the tool Extract by Mask (Spatial Analyst Tools) will need to be used again with 
the site boundary as the masking area to remove the unwanted areas. If this is not done, the 
random assessment points can populate in these areas as well. 
 
Search toolbox for Create Accuracy Assessment Points and select: 
  Input Raster: select classified raster layer 
  Leave Dimension Value Field Blank 
  Output Accuracy Assessment Points: AA_“ClassifiedLayerName” 
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  Target Field: Classified 
  Number of Random Points: N (see box below for suggestion) 
  Sampling Strategy: Stratified Random 

▪ Click Run 

 

  
Figure 9a, b. Site with accuracy assessment points distributed via random stratification within 
the study site boundary to measure classification error and output layer accuracy (left figure). A 
case where the points are incorrectly distributed, and the Extract by Mask tool is needed to 
remove data null areas first (right figure). 
 
▪ Open attribute table from output 
▪ In the Contents pane toggle to corresponding ortho layer 
▪ Right click on the “Classified” header column and select Hide to reduce bias. 
▪ Begin by selecting each row in the attribute table to highlight and focus on the assessment 

point. 
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▪ Under the “Grndtruth” column begin editing each cell for each point by identifying the 
correct strata class and entering in the corresponding field value (i.e., 1 for oyster shell, 10 for 
water, etc.), remembering to zoom in on the orthomosaic as needed (use Crl+ to Zoom to). 

▪ Save edits 
▪ Search tools for Compute Confusion Matrix (Spatial Analyst Tools) 
▪ Run with the updated accuracy point shapefile as the input (make sure none of the rows in 

the accuracy assessment point attribute table are ‘select’ or the option ‘Use the selected 
records’ under the Input Raster is turned off) 

▪ View Confusion Matrix table from the Contents pane (this table should be output at the 
bottom of the Contents pane). 

▪ The diagonal represents correctly classified, the off-diagonal cells represent 
misclassified points 

▪ P_accuracy (producer’s accuracy): proportion of the area for each class that was 
correctly classified 

▪ U_accuracy (user accuracy): proportion of the actual area of each class that was 
classified correctly 

▪ Intersection of P_accuracy & U_accuracy in the matrix is the overall accuracy of the 
classified map 

(For more information on how to read a confusion matrix, see Appendix 5) 
Error should be randomly distributed, and accuracy should be greater than 75%, with expected 
Kappa values: 0.61 – 0.80 Substantial agreement; 0.81 – 0.90 Strong agreement; >0.90 Near 
perfect agreement. Much lower values should suggest a revision to the training sample step to 
adjust the training sample library (either add more samples in areas that performed poorly, 
improve the quality of samples, improve the number of samples, or remove bad samples) 
before moving forward in the workflow. 
 
Do not rely on the accuracy assessment and kappa values alone. Such evaluations are extremely 
helpful, but can be susceptible to bias and fallacies. Also make sure that one or two accuracies 
are not strongly skewing the results. If this is the case, consider merging classes into more 
meaningful groups. For instance, if the classes were Marsh, Sediment (submerged and 
exposed), Oyster Reef (submerged and exposed), SAV, and Water it would be recommended to 
reduce to Marsh, Sediment, Oyster, and Water, or even as far as Non-Oyster and Oyster to 
most accuracy assess the classes most important to the objective (see example supporting 
Tables 2-5 in Appendix). Merging classes will update the stored class values, but a new 
confusion matrix will need to run with updated points. It can be helpful here to copy the 
groundtruth data column into excel and use find and replace to update these points. Once 
updated, they can be pasted back to the updated confusion matrix. The Update Accuracy 
Assessment Points tool (Spatial Analyst Tools) should be used to update points previously 
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classified with a raster layer. Be sure to look at the classification outputs and compare them 
with the study site imagery to get an End User perspective of the model’s performance. 
 
Fill workflow_footprint_database fields AY-BF for Accuracy Assessment 
 
Repeat with other classifications if multiple orthomosaics were run (e.g., rasters from different 
sample time periods) or the model was run with alternative settings or machine learning 
algorithms (i.e., SVM) to find the best output. 
 Search Toolbox for Update Accuracy Assessment Points  

Input Raster: select next classified layer for assessment 
Input Accuracy Assessment Points: select previously used points 
Output Accuracy Assessment points: AA_“ClassifiedLayerName” 
Target Field: Classified 
▪ Click Run 

▪ Groundtruth points should remain the same and already be entered. 
 
▪ Alternatively, the Update Accuracy Assessment Points tool can be used to resample 

raster values at the same previously created random points. This can be useful in 
collecting classified point data from the next classified layer up for evaluation or 
quickly filling the groundtruth data column with information from a previously hand-
defined layer. 

 
6.1 Accuracy Assessment Troubleshooting 
The output confusion matrix table will be in table format. The format of the table is determined 
by the output location and path. By default, the output will be a geodatabase table. If the path 
is not in a geodatabase, specify a .dbf extension to save it in dBASE format. 

7. Classification to footprint 
7.1 Select Strata of Interest 
Click Select by Attribute under the Map tab 
 Input Rows: select the classified layer of interest containing the footprint 
 Selection Type: New selection 

Where: ‘Classvalue’ ‘is equal to’ ‘1’ (this should be the class value of interest since 1 is 
the class value for oyster shell) 

 *Click ‘Apply’ 
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If there are undesired areas incorrectly classified outside of the reef footprint, this or the next 
step is the time to de-select these areas (the lasso tool can be helpful here) and creating an 
intermediate layer from selected features to create a corrected classified layer. 
 
7.2 Convert Raster to Polygon Features 
Analysis Tab � Tools � Raster to Polygon Tool 
 Input raster: select the classified layer of interest containing the footprint 
 Turn on the “Use the selected records” option to include current selection 
 Field: Value 
 Output polygon features: give appropriate name (e.g., Shack_reef_FPpolygons) 
 Check Simplify polygons 
 *Click Run 
 
7.3 Dissolve Polygon Features to make Simplified Polygon Feature Layer 
Analysis Tab � Tools � Dissolve (Data Management Tools) 
 
 Input Features: select the output layer created in with the Raster to Polygon Tool 
 Output Feature Class: name final footprint layer (ex. “Shack_Footprint_RTClassified”) 
 Check ‘Create multipart features’ only 
 *Click Run 
 
If several footprint features remain after the dissolve, use the Merge tool to combine into a 
single feature. 
 
7.4 Supervised Learning Classification Metrics 
Right click on the created final footprint feature in the Contents pane and open the feature’s 
attribute table. Click ‘Add’ next to Field: just above the attribute table, enter Shape_Perimeter 
for Field Name and Alias, set Data Type to Double and Number Format to Numeric. Click the 
Save icon on the ribbon (repeat this process for Shape_Area if it does not already exist). To 
calculate the parameter, right click on the column heading, and select ‘Calculate Geometry’. 
 Field: Shape_Perimeter  

Property: Perimeter length (geodesic) 
 Length Unit: Meters 
 Coordinate System: Select the same as the orthook 
 *Click “Ok” 
 *For large areas, be sure that the Shape_Area is using the Area (geodesic) 
 

Values of Interest: 
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  Footprint area: Found in Field Shape_Area 
  Footprint perimeter: Found in Shape_Perimeter 
  
Fill workflow_footprint_database fields BL-BP (Grid Classification). 

8. Areal Footprint Compare 
Resulting footprints from the various approaches can be compared by adding the polygon 
shapefile data layers of each. In addition to displaying and comparing each approach or time 
period's resulting layer, the total area and perimeters can be viewed in the respective attribute 
tables as well as in the Reef_Footprint_Database. 
                                                                                                                                                                                                                                                                                
8.1 – Percent Cover / Patchiness 
This can be calculated at the reef scale by dividing the total area of oyster within a delineated 
area by the area of that delineated area. For the most accurate assessment of this metric, use 
the reef area extent that is created in section 8.3 (below). 

 
Note: The selected classified area may need to be clipped using the Extract by Mask tool 
(Spatial Analysis Tool) with the chosen delineated area as the feature mask data.  
Fill workflow_footprint_database fields BQ (where applicable) 
 
8.2 – Change Detection 
To evaluate how a site may be changing over time, classified feature layers can be compared 
spatiotemporally. One approach is to create an overlay map of the various footprints with 
transparency added to each layer of interest (Figure 10). [A layer’s transparency can be 
adjusted by selecting that layer in the Contents pane → clicking Feature Layer or Raster Layer 
tab → Adjusting the Transparency setting] 
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Figure 10. Change in reef areal footprint at Hollowing 
Reef, North River, NC illustrates the capabilities of 
UAS to define oyster reef areas and detect areal 
change from delineated orthomosaic layers. This 
study site was classified with 367.7 m2, or 23.3% more 
reef area in 2022 than in 2020, suggesting reef 
accretion. Heads-up delineation and classification 
were utilized to define the 2020 and 2022 shell layers 
(spatial resolution of 25x25 cm). 
 
 
 
 
 
 

A more detailed analysis can be conducted using the Change Detection tool (Figure 11). This 
tool allows users to detect areas of loss, gain, and stability across two rasters or data layers. 

Change Detection Method: Categorical Change (For those with longer time series, Time 
Series Change could be worth running as well; Change Detection Wizard—ArcGIS Pro | 
Documentation) 

 From Raster: select initial raster 
 To Raster: select newest raster 

Field names: can be used if your raster contains multiple fields still and interest is only in 
one. 
Processing Extent: at a minimum this should be set at the extent of your smallest raster. 
This is another instance where setting an appropriate site boundary is useful and can 
again be used. However, best accuracy and results will occur using a delineated extent 
or a raster that under when heavier masking. For example, you can see numerous 
artifacts that remain off the reef in Figure 11 that if left in the analysis will skew the 
results. The extract by Mask tool can also be applied after running the Change Detection 
tool to remove these inaccuracies. 

The output layers will provide counts for stable, gained, losses for each class. The counts can be 
viewed in the attribute table and area can be calculated by creating a new area field. 
 
 

https://pro.arcgis.com/en/pro-app/latest/help/analysis/image-analyst/the-change-detection-wizard.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/image-analyst/the-change-detection-wizard.htm
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Figure 11. Change detection map of Town Marsh 
Lagoon from Fall 2022 to Summer 2023 showing 794 m 
of stable shell area, 402 m of shell area 
change/anomalies, and 7806 m area of stable 
sediment. Future runs will work to reduce anomalies 
and improve estimate accuracy. 
 
 
 
 
 
 
 
 
 

 
 
 
 

9. Assessing Delineated Footprint Boundary Accuracy 
9.1.  Add RTK Points to Map. 
At sites where footprint was RTK delineated in the field, RTK points should be used to assess 
delineated and classified footprint edge accuracy. If they have not been uploaded already, go to 
Catalog, and add the .csv file containing the RTK footprint/boundary points to the project. 
This can be accomplished either by: (a) adding a table or  (b) selecting ‘XY data’ (under the add 
data dropdown) and creating a shapefile.  
 
*Be sure to set X to Easting, Y to Northing, and Z to Elevation (again, check that the coordinate 
system matches the orthomosaic raster). 

-  Once added, points may need to be binned into their corresponding feature 
type/ecotone (i.e., footprint, reef-water boundary, subtidal shell extent, reef-marsh 
boundary, reef axis, profile, etc.) 
-  Open the attribute table and select all the points of each desired feature type 
- Right click on the feature class in the Contents pane, click Selection � Make Layer from 
Selected Features 
- Rename the newly created feature class to the correct category (i.e., oysters), labeling 
‘RTK’ as appropriate. 
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9.2.  Generating Digital RTK (optional). 
Note: For sites that were not RTK delineated in the field, digital check points can be created 
either independently from the RGB orthomosaic (Option 1) or from the Heads-up delineation 
(Option 2). [Some may be interested in doing this anyway to compare RTK footprint points to 
the RGB ortho image to note any difference or discrepancy. For those interested in assessing 
this, be sure to pair the new point placement with RTK points. Later the two-point shapefiles 
will be selected in the Near tool for comparison.] 
 
Option 1: Create independent checkpoints from RGB ortho 

 
Analysis → Tools → Create Feature Class (Data Management Tools) 

         Feature Class Location: select project geodatabase 
         Feature Class Name: Digital_FootprintCheckpts 
         Geometry Type: Multipoint 
         Coordinate System: set to site ortho layer 

▪     Leave remaining options as default 
 *Click Run 

 
▪ Toggle on the appropriate ortho layer. 
▪ On the ribbon, click Edit, Create icon, select Digital_FootprintCheckpts and begin 

clicking  on the ortho layer along the footprint eco-tone/reef edge to create the 
footprint boundary. It is recommended to aim for ~1m point placement if possible. 

▪ Poorly placed points can be deleted by right clicking on a point and selecting delete 
vertex. Clicking the  button will delete all newly created points. Once point placement 
is completed, select the  button to save as the updated layer in the Contents panel. 

▪ Once created, this feature can be modified by clicking the Modify icon on the ribbon 
 
Option 2: If RTK points were not collected in the field for the site, the geoprocessing tool 
“Generate Points Along Lines” can be used with any other delineated footprint layer that has 
been converted to a polyline or polygon shape file. 
 

Geoprocessing � Select tools � Generate Points Along Lines (Data Management Tools) 
         Input Features: select chosen delineated footprint feature 
         Output Feature Class: name accordingly (example: random_footprint_pts) 
         Point Placement: By distance 
         Distance: 1 Meter 

* Click Run 
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Note: Check the Contents panel for all the site’s digital delineated polygon and polyline 
shapefiles. 
If not there, upload these features to the project (these should have been created in previous 
steps: outputs from Head’s-up Delineation, Grid Delineation, Supervised Learning 
Classification). 
  
9.3. Preparing Footprint Polygon Features 
Footprint polygon features will need to be augmented for an accurate edge assessment, 
percent cover, and full footprint extent (this is especially true with patchy footprints as polygon 
holes and patchiness will result in incorrect features registering as the nearest feature). 
 
9.3.1. Using the polygon footprint layer derived from the classified raster follow the steps 
below: 
         

Geoprocessing Tools → Eliminate Polygon Part (Data Management Tools) 
Input Features: select classified polygon layer 
Output Feature Class: “name of classified polygon layer_filled”(extension  .shp) 
Condition: Area 

            Area: input a value in square meters larger than the reef footprint itself 
*Check “Eliminate contained parts only” 

             

 
 

Figure 12: Example of a classified reef polygon footprint layer prior to augmentation-- 
eliminating polygon part (left); polygon footprint after processing augmentation. Yellow circles 
indicate the reef axis ground-truth points and  blue circles the reef RTK points. 
 

 



69 
 

        Geoprocessing Tools → Polygon to Line (Data Management Tools) 
            Input Features: select output from Eliminate Polygon Part tool 
            Output Features: “name of classified polygon layer_line” 
            *Check “Identify and store polygon neighboring information.” 

 
Repeat with all final footprint polygon shapefile layers. 
  

 
Figure 13: Classified reef line footprint layer (pink) post processing “eliminate polygon part” and 
“Polygon to line” geoprocessing tool.  Yellow circles indicate the reef axis ground-truth points 
and blue circles the reef RTK points. 
 
9.4. Footprint Boundary Accuracy 
Geoprocessing Tools → Analysis Tools → Near (Analysis Tools); [Near (Analysis)—ArcGIS Pro | 
Documentation]  

Input Features: select shapefile with RTK footprint of interest 
Near Features: select the computer-based delineation layer (Heads-up, Grid, 
Classifications) 
Method: Geodesic 
Field Names: Leave the same or update field names accordingly 
Distance Unit: Meters 

            *Click Run 
 
Repeat with all layers as needed. 

 

https://pro.arcgis.com/en/pro-app/latest/tool-reference/analysis/near.htm
https://pro.arcgis.com/en/pro-app/latest/tool-reference/analysis/near.htm
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**The output is a computed distance between the RTK footprint line layer and the NEAR 
feature added (i.e., classified footprint line). This is added to the RTK footprint line layer 
attribute table. 
 

 
 

 9.5. Viewing Results 
Open attribute table of each layer selected for as the “Near Feature” in the Near tool 
* Right-click on the column and select “Statistics” 
* View mean and standard deviation for statistical analysis of RTK measured and digitally 
delineated reef footprint edge. 
* Graphs and tables can be exported and saved. 
 
Fill workflow_footprint_database fields BG-BK (where applicable) 

10. Sharing and Uploading Projects 
10.1 Exporting ArcGIS project (.ppkx) 
- Exported footprint projects are located at the following path: 
\imagery_analysis_arcgis_packages\xxx\footprint (where xxx = reserve initials) 
 
Share tab → Project (left side). 

● Start packaging = “Save package to file”. 
● Item details = change the file location and name, as appropriate. 

1. If the projects are reef-specific, save the files 
as: xxx_zz_mmddyy_footprint.ppkx, where xxx = reserve initials, zz = 
reef initials, mmddyy = date sampled 
(e.g., noc_mm_071423_footprint.ppkx). 

2. If the projects are workflow-specific, and contain all reefs, save the file 
as: xxx_allreefs_yyyy_footprint.ppkx, where xxx = reserve initials, yyyy = 
year sampled (e.g., noc_allreefs_2023_footprint.ppkx). 

3. For the experimental reefs, save the files in one of the two formats listed 
above, and add ‘_experiment.ppkx’ at the end of the 
name (e.g., noc_mm_030824_footprint_experiment.ppkx). 



71 
 

● Select the checkbox for “Share outside of organization”. Make sure all other 
checkboxes are unselected. 

11. Appendices 
11.1 Creating an ArcGIS Pro Database 
Create a project folder to house your project, associated files, and ArcGIS Pro database 

▪ This is a good time to create a “Data Inputs” folder and add copies of the original 
study site orthomosaics, DSMs, and other associated layers/files (these can later be 
moved into a geodatabase as preferred). 

▪ See the linking for further information on ArcGIS Pro geodatabases (What is a 
geodatabase?—ArcGIS Pro | Documentation) and assistance in creating an ArcPro 
database (Create a file geodatabase—ArcGIS Pro | Documentation). 

Open ArcGIS Pro and select the map icon under New Project 
▪ Name new project accordingly 
▪ Under Location, navigate to the newly created project folder 
▪ Uncheck create a new folder for this project (this should have already been created in 

the previous step) 
 
11.2 Importing RTKs points and Creating Layer 
Transform RTK points to point layer 

Under the Map tab, 
Select add data, 
navigate to the data file (.csv) located in the computer folder. If RTK data is stored in 
Excel file, make sure the file is saved as a .cvs from Excel. 

 
1.  Display data 

On the Contents pane, 
Right click the newly added table, 
select → display x/y→ assign “x field” to Easting, “y field” to Northing, and “z field” to 
elevation columns    

2.  Table to point 
Under “Analysis” tab, 
click the geoprocessing toolbox 
Select “XY table to point”  

https://pro.arcgis.com/en/pro-app/latest/help/data/geodatabases/overview/what-is-a-geodatabase-.htm
https://pro.arcgis.com/en/pro-app/latest/help/data/geodatabases/overview/what-is-a-geodatabase-.htm
https://pro.arcgis.com/en/pro-app/latest/help/data/geodatabases/manage-file-gdb/create-file-geodatabase.htm#:%7E:text=Use%20the%20Catalog%20pane%20in%20ArcGIS%20Pro,-Follow%20these%20steps&text=Right%2Dclick%20Databases%20or%20a,a%20name%2C%20and%20click%20Save.
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3.  Creating boundary as a polygon from RTK point data 
To create the individual reef-specific boundaries use the processed RTK point layer to snap line 
segments that build the boundary of each reef to the RTK points. 

In the geoprocessing toolbox search: “points to 
line” 
  
Input features: the individual reef RTK point 
Output feature class: the name for the new RTK 
line (boundary) file 
Check the box for ‘close the line’ 
Select ‘construct continuous line’ from the Line 
Construction dropdown menu 
Attribute source: none 

 
 

 
Figure S1. SCDNR Sample reef 1 (site1) RTK points (left); output of reef 1 RTK points snapped as 
a line feature class (right) after geoprocessing. 
 
11.3 Creating Unique Project Schema and Training Samples 
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A classification schema determines the number and types of classes to use for supervised 
classification. Schemas can be hierarchical, meaning there can be classes within subclasses.  
When creating the training samples, it is important to consider: 

(a)  The quality of the training samples before running the classification 
(b)  The proportionality of the training samples across the different classes 
(c)   Capturing spectrally pure pixel-level samples — meaning, no overlapping pixels in  

different categories and unimodal color histograms per class. 
*It may be helpful to create a table of the different color pixels presented in the segmented 
image to distinguish the classes (refer to Figures S2 and S3 for examples). Doing this can define 
the classes and subclasses more accurately to avoid confusion or color overlap that may 
confuse the image classification algorithm. 

 
Figure S2. Example of training sample polygons for dark sediment pixels on mud areas (left) and 
in vegetation (right). 

 
Figure S3. Overview of pixel distinction for multiple classes captured as unique training 
samples. 
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Figure S4. A sample table of the pixel color variations identified in the imagery that were used 
as guidance to create the schema and training samples. 
 
11.4 Guidance on Selecting Support Vector Machine (SVM) or Random Tree (RT) 

 
Figure S5. Factors of consideration and guidance on selecting SVM vs RT. 
 
11.5 How to read a Confusion Matrix 

▪ Each cell dictates the number of points that were correctly or incorrectly identified. The 
graphic below (Figure S6) gives a good description of how each cell(s) is classified. In the 
case of the oyster reef footprint, imagine that the purple squares make up the two cells 
outside the diagonal line, not just one. 

▪ You can modify the confusion matrix to show how specific classifications compare to the 
rest (Figure S7). 

o For example, you can isolate the Underwater Shell class and compare its 
accuracy to the rest of the classes, since this class usually has the most trouble. 
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Figure S6 and S7. A step-by-step guide to reading and comprehending a confusion matrix. 
 
 
11.6 Composite Bands and Ruggedness Layers 
In cases where surveys result in additional data layers (i.e., multispect, ruggedness layer, etc.) 
the Composite Band tool can be used to stitch these individual layers together for use along 
with the RGB ortho so that End Users are not limited to selecting/making use, of only one 
additional data layer. On average, ruggedness layers, such as Terrain Ruggedness (TRI) or 
Vector Ruggedness Measure (VRM), improved classification accuracy when classification 
remained poor from RGB and/or DSM layers alone. More detailed instructions on creating TRI 
and VRM layers can be found in the Oyster Percent Cover and Oyster Density workflow 
sections. 
 
11.7 Seed Points for Training Samples 
The Seed Points tool is a great way to guide where training samples are created especially for 
End Users who are interested in creating train samples around their groundtruth areas. 
Generate Training Samples From Seed Points (Spatial Analyst)—ArcGIS Pro | Documentation 

 
 
Supporting Tables 
Accuracy Assessment Result Examples and explanations for handling classes 
 

https://pro.arcgis.com/en/pro-app/latest/tool-reference/spatial-analyst/generate-training-samples-from-seed-points.htm
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Table 1. Unmerged Classes – Fine Resolution Confusion Matrix. 

 
Confusion matrix summarizing classification accuracy assessment for the Town Marsh Lagoon 
study site, North Carolina (2022). Individual habitat strata include C_1 = exposed oyster shell; 
C_2 = submerged oyster shell; C_10 = water; C_30 = exposed sediment; C_35 = submerged 
sediment. This classification achieved an overall accuracy of 93.91% and a Kappa coefficient of 
0.827, indicating strong model agreement beyond chance. Oyster shell (C₁) exhibited strong 
performance with a User’s Accuracy of 84.4% and Producer’s Accuracy of 86.4%, while other 
classes such as sediment (C_30) and water (C_10) also showed high accuracy. 
 
This example provides a detailed view of classification performance at a fine resolution. While 
valuable for assessing subclass behavior (e.g., exposed vs. submerged habitats), such 
granularity may increase observed confusion due to visual or spectral similarity. These 
distinctions are crucial when ecological processes differ between subclasses, but they may also 
lower apparent accuracy despite solid model performance. 
 
Table 2. Grouped Classes – Simplified Confusion Matrix. 

 
Confusion matrix showing classification accuracy after grouping similar classes at the same site 
and survey period (Town Marsh Lagoon, NC, 2022). Grouped strata include: C_1 = all oyster 
shell (exposed and submerged); C_10 = water; C_30 = all sediment (exposed and submerged). 
The model achieved an overall accuracy of 96.86% and a Kappa coefficient of 0.859, indicating 
excellent agreement beyond chance. For the grouped oyster class, User’s Accuracy reached 
94.8%, and Producer’s Accuracy was 93.2%, reflecting minimal misclassification and robust 
model performance across habitat types. 
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This example illustrates the benefits of intelligently grouping classes: it improves clarity, 
minimizes within-group confusion (e.g., between exposed and submerged shell), and aligns 
with ecological management goals focused on broader habitat categories. However, while 
accuracy metrics are improved, fine-scale differences are masked — making this approach best 
suited for applications prioritizing general habitat detection over detailed habitat structure. 
 
Table 3. Grouped Classes – Oversimplified Confusion Matrix.

 
Confusion matrix showing classification accuracy for grouped habitat classes at the Town Marsh 
Lagoon study site, North Carolina, surveyed in 2023. Grouped classes include C_1 = all oyster 
shell (exposed and submerged); C_10 = water; C_30 = all sediment (exposed and submerged). 
The model achieved an overall accuracy of 75.0% and a Kappa coefficient of 0.577, indicating 
moderate agreement beyond chance and a decline in performance relative to the 2022 
grouped model. Image quality was notably affected by sun glare during the 2023 survey, 
contributing to classification challenges. The User’s Accuracy for the oyster class was 68.0%, 
and the Producer’s Accuracy was 94.4%, suggesting that while most true oyster pixels were 
detected, a substantial number of false positives reduced classification reliability from a user 
perspective. 
 
This example highlights some of the limitations of grouping when classification performance is 
lower overall. Although grouping helped capture broad habitat trends, it also obscured specific 
sources of confusion and error. For example, this was particularly the case between sediment 
and water, where misclassifications were more frequent (e.g., 27 water-labeled pixels 
incorrectly classified as sediment). Ungrouping would be more informative in addressing 
poor/inadequate samples and retraining the model or simply removing underperforming strata 
if of less importance. These patterns suggest a clear need to retrain the model using an 
improved and balanced training dataset, especially for underrepresented or frequently 
confused classes such as water. Additionally, the classification would benefit from more 
randomly distributed assessment points to better capture water and sediment zones, to reduce 
sampling bias, capture misclassification trends in transitional or low-contrast areas, and 
increase confidence in oyster reef accuracy values. This case, compared to the 2022 examples, 
demonstrates that grouping alone cannot compensate for broader issues in image quality, 
training representativeness, or class confusion. However, even with a lower performance, the 
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model is still acceptable, and the grouped approach provides a useful high-level habitat 
overview. 
 
Table 4. Binary Classification – Oyster Reef vs. Not Oyster Reef.

 
Confusion matrix summarizing binary classification accuracy at the Town Marsh Lagoon study 
site, North Carolina, surveyed in 2023. Classes were grouped into: C_1 = oyster reef (exposed + 
submerged shell), C_0 = non-oyster reef (water + all sediment types). 

The model achieved a high overall accuracy of 95.5% and a Kappa coefficient of 0.766, 
reflecting strong agreement beyond chance for a binary classification. The User’s Accuracy for 
oyster was 68.0%, while Producer’s Accuracy was 94.4%, indicating that most true oyster areas 
were detected, but many predicted oyster pixels were false positives. In contrast, the not-
oyster class showed excellent performance (User’s Accuracy = 99.4%, Producer’s Accuracy = 
95.6%). 

This example illustrates both the strengths and limitations of extreme class grouping. Binary 
classification simplifies interpretation, improves overall accuracy, and aligns well with 
management objectives focused on oyster presence or absence (e.g., restoration planning or 
regulatory thresholds). However, it also masks internal confusion within the non-oyster class 
(such as between sediment and water) and highlights the model’s tendency to overpredict 
oyster habitat. This overprediction likely stems from glare in imagery, along with generalization 
issues or class imbalance in the training data, particularly in complex areas like patchy reefs or 
habitat edges. To address this, retraining the model with more representative oyster samples 
and expanding the spatial distribution of validation points—especially across transitional or 
visually ambiguous zones—could reduce false positives and improve the model’s reliability 
across diverse spectral conditions. 

Compared to the more detailed 2023 grouped classification (Table 3), this binary approach 
yields cleaner metrics and is suitable for coarse-scale decision-making — but it should be paired 
with finer-scale validation when spatial accuracy of oyster habitat is paramount. 
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12. Digital Reef Classification & Footprint Assessment Cliff Notes 
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V. Oyster Percent Cover Workflow  
 
Workflow lead and contact: Allix North (allix.north@floridadep.gov) 
 
Overview 

1. Prepare map project 
2. Set up the data template spreadsheet 
3. Create/orient quadrats 
4. Calculate total oyster percent cover 
5. Calculate focal statistics 
6. Calculate TRI 
7. Combine and extract oyster class 
8. Tabulate TRI areas for each quadrat  
9. Set up Excel worksheet 
10. Adjust values to proportion of quadrat size 
11. Calculate cumulative sum of each quadrat  
12. Run Solver tool & calculate thresholds 
13. Create vertical oyster, cultch, and sediment layers 
14. Export arcgis project 
15. Appendix (formulas; TRI manual method; VRM process) 

 
Input files needed 

The following files will be used, from the Oyster Reef Elevation and Elevation Change Workflow:  
● Corrected clipped pre-excavation DSM (This will be the same DSM used to create 

your Classified Raster; RMSE corrected and clipped to same extent used in other 
workflows) 

o Note, for experimental reefs, you will follow the workflow using the pre-
harvest DSM, and then again using the post-harvest DSM if percent cover 
data were collected in-situ before and after harvesting.  

● Table to Point RTK data for in-situ quadrats OR developed polygon quadrats 
● RGB orthomosaic (for visual ground-truth reference) 

And from the Oyster Reef Footprint workflow:  
● Classified Raster (the final classified raster output containing all classes); the goal is 

to capture live oyster and shell for this processing. Note, the classes and code values 
used to classify oysters, shell and sediment in the footprint workflow. 

● Simplified Polygon Feature Layer of intertidal oysters only (created in Section 6 of 
the footprint workflow using the Dissolve tool).  

mailto:allix.north@floridadep.gov
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1. Preparing the map project 
1.1. Prior to starting, decide whether all sampled reefs will be housed in the same 

ArcGIS project (e.g., each reef will have a separate Map tab), or if each ArcGIS 
project will house an individual reef.  

Note, your decision will affect the naming convention of the final exported ArcGIS 
project(s), specified at the end of the workflow. 

1.2. Add corrected DSM created in the Oyster Reef Elevation and Elevation Change 
Workflow.  

1.3. Add the RTK Point data for all percent cover quadrats.  

Note, some reserves may have recorded all 4 quadrat corners, while others may 
have only recorded the center point and one corner. If you did not create these 
points in the DSM Workflow, then follow these steps: 

1.4. Under Map tab at the top, add data, navigate to quadrat point file (.csv). 

1.5. Right click .csv  file → Create Points from Table (note, older versions of ArcGIS 
Pro may use ‘display x/y’) → choose “XY Table to Point” → Make sure the 
coordinate system is right (choose the DSM you just brought in to check) → 
Assign “x field” to Easting, “y field” to Northing, and “z field” to Elevation 
columns and ignore the warning message if one pops up, which means there 
were empty cells it did not include. 

1.6. Add the Classified Raster and the Simplified Polygon Feature Layer of intertidal 
oysters only created in the Oyster Reef Footprint Workflow. 

2. Setting up the data template spreadsheet 
2.1. Open the data template (“workflow_percent_cover_database.xlsx”) from 

\imagery_data_spreadsheets. 

2.2. In columns A-H, fill in the site/reef metadata, which can be copied and pasted 
from the in-situ data template.  

Note, make sure to create the same number of rows as there are percent cover 
quadrats (e.g., if percent cover data was collected in 3 quadrats at Reef 1, there 
will be three rows of data in the spreadsheet for said reef). 

2.3. In column I, copy the names of each quadrat from the in-situ data template, and 
in column J, fill in the name of your ArcGIS project. 

 

3. Creating/Orienting quadrats 
If using 4-corner points:  

3.1. Load quadrat point file containing center and corner points collected in the field. 
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3.2. Go to Geoprocessing Tools, search for and open ‘Create Feature Class’. 

 -Feature Class Name → per_cov_quads 
 -Geometry Type → Polygon 
-Coordinate System → Select from dropdown menu a -
DSM/orthomosaic/other file with the coordinate system of interest (e.g., 
-NAD 1983 2011 UTM Zone 18N, NAVD88). 

 -Leave the remaining variables unchanged. 
-Click Run. 

3.3. Go to the Edit tab (top ribbon), select “Create” and choose the polygon feature  
class just created under the “Create Features” window on the right side. 

3.4. Also in the Edit tab, set the xy snapping tolerance1  to 10 pixels by opening the  

Snapping Settings. 

3.5. Once finding the points associated with the first percent cover quadrat, right 
click on one of the quadrat corner points and choose “Snap to feature” → 
“Vertex”. 

Make sure no PVC is included in the polygon if quadrats were left on 
the reef during the drone flights. 

3.6. Repeat this snapping process for each corner of the plot, and double click the 
last corner to close the polygon.  

 

If using center point and one corner point:  

3.7. Select one point from each quadrat point. 
The center point works best to complete 
the steps. 

3.8. Create a buffer around a point feature in 
ArcGIS Pro. The Buffer tool creates a 
circular polygon buffer by default when 
used on a point feature. The circular 
buffer can be used as a base to create a 
square buffer.  

3.9. Go to Geoprocessing Tools, search for 
and open ‘Buffer’. 

Input Feature → “quadrats table to point file” 
Output Feature Class → quadrats_Buffer.shp 

 
1 Use snapping—ArcGIS Pro | Documentation 

https://pro.arcgis.com/en/pro-app/latest/help/editing/enable-snapping.htm
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Distance → should be set to half the distance of one side of the quadrat 
size (in meters) using linear units (e.g., if quadrat size is 0.25m^2 then 
distance = 0.125m). 
Leave the remaining variables unchanged. 
Click Run. 

 

As an example, if the quadrat area = 0.25m^2, then the radius is half that distance or 
= 0.125m (distance linear unit on each side of the center point). To create the polygon 
using the buffer tool, we use that radius distance to extend from the center point. 

 

3.10. Go to Geoprocessing Tools, search for and open ‘Minimum Bounding Geometry’. 
Create a square envelope for the buffer in the next steps. The newly created 
shape will be the quadrats. 

-Input Features → Quadrats_Buffer.shp 
-Output Feature Class → Quadrats_polygon.shp 
-Geometry Type → Envelope. (Using envelope will ensure the quadrat 
polygon we create captures the full extent of the buffer area---like an 
envelope) 
-Group Option → None 
-Click Run. 

3.11. Once the quadrat polygons are created, adjust location and orientation to match 
the corners of the actual quadrat points taken in the field.  

3.12. Use the Edit tab and select “move” from the Tools (OR Feature → modify) to 
rotate the quadrats in the direction of the corner point.  

Note, do not adjust size, only move and rotate to orient the polygon to match the 
orientation of the quadrat points. 

 

Naming the quadrat polygons:  
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3.13. Right click on the layer and open the attribute table. 

-Field → Add 
-Field Name → Plot_name 
-Alias → Plot_name 
-Data Type → Text 

3.14. Click Save on the top ribbon and close the “Fields” tab. 

3.15. Go to the Edit tab, click Edit, and select Attributes button.  

3.15.1. In the panel that opens on the right, rename the “Plot_name” field 
created in the previous step; make sure the name matches whichever 
quadrat you are working on (e.g., if you created the polygon around the 
RTK coordinates for quadrat 1, then the plot_name field would be labeled 
as “percov_1”). 

3.15.2. Repeat this step for each plot, going in order of what the plots were 
named (percent cover quad 1 first, percent cover quad 2 second, etc.). 

3.15.3. Save edits and click “Edit” in the top ribbon to end the editing process. 

3.15.4. Each polygon quadrat should now have a name assigned to it. 

4. Calculating total oyster percent cover 
4.1. Go to Geoprocessing Tools, search for and open ‘Summarize Within’ (Analysis 

Tool). 

-Input Polygons → quadrat polygons created in step 3 
-Input Summary Features → Simplified Polygon Feature Layer of only 
intertidal oysters (created in section 6 of the Footprint workflow) 
-Output Feature Class → intertidal_total_oyster_cover 
Check the boxes for “Keep all input polygons” and “Add summary 
attributes” 
-Shape Unit → Square meters 
-Click Run. 

4.2. Go to Geoprocessing Tools, search for and open ‘Table to Excel’. 

-Input Table → table created with Summarize Within tool 
Make sure to toggle off the “Use selected records” button 
-Output Excel File → intertidal_total_oyster_cover_table 
-Leave “Use field alias as column header” and “Use domain and subtype 
description” boxes unchecked. 
-Click Run. 

4.3. Open the exported Excel spreadsheet and add a new column to the right of the 
existing columns, labeled “oyster_coverage”. 
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4.3.1. In this new column, type the formula: = (sum_Area_SQUAREMETERS) / 
(Shape_Area) (e.g., E2 / D2).  

4.3.2. Drag this formula to populate cells for all quadrats. 

4.3.3. All values should be less than or equal to 1, since 1 represents a percent 
cover of 100%. 

4.4. In column R of the data template, copy and paste the values from the 
“oyster_coverage” column that was calculated in Excel (one row per quadrat).  

Note, make sure the order of quadrat polygons in both tables matches before 
copying and pasting the data. 

4.5. In column Q of the data template, enter the formula “= 1 – column R” (e.g., 1 – 
R2). This is the percent cover of anything other than oyster (e.g., sediment, 
marsh vegetation). Columns Q and R should add up to 1. 

5. Focal Statistics 
5.1. Go to Geoprocessing Tools, search for and open ‘Focal Statistics’. 

-Input Raster → Corrected clipped pre-extraction DSM   
-Set Neighborhood → Rectangle, width = 3, height = 3, Units type = Cell 
-Statistic type → Mean 
-Output Raster → Focal_Mean 
-Click Run. 

5.2. Repeat step 5.1 two more times changing the statistic Type to “Min” and “Max” 

Note, this will give you three outputs total (Mean, Min, and Max elevation for 
each 3x3 neighborhood). Make sure to change the output raster name for each 
output.  
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5.3. In column K of the data template spreadsheet, enter the neighborhood size (e.g., 
3x3). This value will be the same for all quadrats. 

6. Calculate Terrain Ruggedness Index (TRI)  
6.1. Go to Geoprocessing Tools, search for and open ‘Raster Calculator’. 

Using the three focal statistic outputs you created in the previous step 
calculate TRI. To calculate, set the parentheses in order and for each 
space double click the raster file. It should appear on the raster calculator 
window as part of the formula.  

-Formula → ((Focal_Mean)-(Focal_Min))/((Focal_Max)-(Focal_Min)) 
-Output Raster → TRI 
-Click Run. 

 
` 
Output TRI Raster has a TRI range varying from 0 to 
a max value (typically 1). 

6.2. Go to Geoprocessing Tools, search for and open 
‘Raster Calculator’. 

-Formula → Input TRI * 100 
-Output Raster → TRI_100 
-Click Run. 

6.3. Go to Geoprocessing Tools, search for and open 'Int’ (this creates an Integer 
Raster). 

-Input Raster → TRI_100 
-Output Raster → TRI_Int 
-Click Run. 

6.4. In column L of the data template spreadsheet, enter in the range of values in the 
TRI integer raster created in the previous step. This range will be the same for all 
quadrats. 

 

Progress check: 6 outputs                                                                                           

DEM 3x3 mean.tif                                           
DEM 3x3 min.tif 
DEM 3x3 max.tif                                             
DEM 3x3 TRI.tif 
DEM 3x3 TRI_x100.tif                
DEM 3x3 TRI_100Integer.tif 
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7. Combine rasters and extract oyster class 
Combine (a) the raster of the classified reef with (b) the TRI_100integer raster to 

continue with the following steps. 

Combining the two products mentioned above will result in another raster that merges 
the oyster class_value of the Classified Raster with the TRI integer value for each 
cell in the image neighborhood. 

7.1. Combine TRI and classified raster: (include all intertidal oysters –including 
exposed oysters-- that were captured during the footprint classification process). 
Remember, we are using the final classified raster output created from the 
footprint workflow. 

7.2. Go to Geoprocessing Tools, search for and open ‘Combine’. 

-Input Rasters → Classified Raster from Footprint workflow and TRI_Int 
-Output Raster → Classified_TRI_Combine 
-Click Run. 

7.3. Go to Map Tab and select “Select by Attribute” to select the classified oyster 
values. (e.g., oyster Class_Value = 1) from the output created above 
(Classified_TRI_Combine). 

-Input row → combined raster 
-Selection Type → New 
-Expression → where Classified Raster Row in your new table “is equal 
to” class code for Oyster 
-Click apply 
 
Note, if completing this step for the experiment, make sure to use the 
classified raster from the correct footprint workflow (either pre-
excavation or post-excavation). 

 

In the image below the classified raster is “Classify_SR_SR7_DSMOnly_3x3int” 
and the Class Code for Oyster is “1” 
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7.4. Go to Geoprocessing Tools, search for and open ‘Extract by Mask’. 

-Input Raster → Classified_TRI_Combine 
-Keep the toggle checked for “Use the selected records”. 
-Input raster or feature mask data → Classified_TRI_Combine 
-Output Raster → Extract_Oyster_Classified_TRI_Combine 
-Extraction Area → Inside 
-Analysis Extent → Extent of Layer (third tab over)  
Select drop down and select the Classified_TRI_Combine layer.  
-Click Run. 

7.5. In column M in the data template, enter the range of values in this newly created 
TRI raster for live oysters only. 

Note, the scale bar in the contents pane might show a max value greater than 
100. Make sure to open the attribute table and check that the range of TRI values 
does not exceed 100. 
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Progress check:  2 outputs                                                                                                        

Combined_classified _3x3TRI_int_raster.tif 
Combined_classifiedliveoysterextract__3x3TRI_int_raster.tif 

 

8. Tabulate Area 
8.1. Go to Geoprocessing Tools, search for and open ‘Tabulate Area’. 

-Input raster or feature zone data → Quadrat_polygons 
-Zone Field → Attribute field that contains quadrat name 

Note, if a numeric new field was created to label the quadrats 
(e.g., 1, 2, 3), make sure to choose “long” for data type and 
“numeric”.  

-Input raster or feature class data → 
Extract_Oyster_Classified_TRI_Combine 
-Class field → Attribute field that contains the TRI data (in example below 
that is called ‘Int_TRI100’) 
-Output Table → TRI_Tabulation_table.dbf 
Leave the processing cell size as the default. 
-Click Run.  
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8.2. Go to Geoprocessing Tools, search for and open ‘Table to Excel’. 

-Input Table → TRI_Tabulation_table.dbf 
-Output Excel File → TRI_Tabulation_table.xls 

Note, the range of TRI values generated at each reef may differ from this 
example. As a result, the cells selected for your formulas will differ from the 
examples provided in the steps below, which are just for illustrative purposes. 

 
 
Progress check:  3 outputs                                                                                                        

Quadrat_polygons.shp 
TRI_Tabulation_table.dbf 
TRI_Tabulation_table.xls 

 

9. Set-up Excel workbook 
9.1. Open the excel file generated above.  

9.2. Import your estimated in-situ percent cover data (as a decimal) for 3d/live 
oysters. Make sure you enter percent cover values associated with the correct 
quadrat for each site. 

9.3. Set the in-situ percent cover data and the TRI estimated values side by side to 
mirror each other in a row format.  
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In the figure above, the top row is the TRI value identifier (red), and each cell 
(blue) is the tabulated 3d/live oyster area value for each quadrat in that specific 
TRI threshold.  

10.  Adjust tabulated values table 
10.1. Table cell values. In this section, we standardize the tabulated area values (cell 

values) to a proportion relative to the quadrat size, so that all quadrats together 
sum up to 1 or 100%. This will allow us to compare the areas for each TRI cell 
equally. 

10.2. Below the original table from step 9, copy the table formatting and paste on the 
same sheet below the original table. The new table's cells should remain blank. 
These blank cells will be filled with values after the quadrat size adjustment is 
made.  

 

 
Each cell in the quadrat row represents an area of 3D shell/live oysters identified 
within the TRI threshold indicated.  

10.3. Create a new column in the first table and label it “rowsum”. Type “=sum(select 
quadrat row)” to calculate the total row sum area. 

10.4. Repeat step 10.3 for all quadrats.  

10.5. In the empty formatted table, look for the equivalent quadrat cell and type the 
formula “=(select cell value) / (select quadrat row sum)”. 

Note, the rowsum total should be equal to 1, if it isn’t, double check calculations.  

Table formulas 

Rowsum = sum(select quadrat row) 

Proportion-adjusted cell value = (Cell area value) / (total row rum area) 
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10.5.1. In the figure above, Row 6 (quadrat rf2-q1-ct) has a total row sum of 
0.042784. At TRI threshold of TRI-88 (BZ6) the area of 3D shell/ live 
oysters present = 3.18E-05.  

3.18E-05 / 0.042784 = 0.000743 

 

The formula adjusted the cell area to a proportion for BZ19 (in quadrat 
rf2-q1-ct). This means that the proportion of 3d shell/ live oysters 
identified for this quadrat is about 0.0743% for a TRI-88 threshold.  

10.6. After completing the quadrat value adjustments, copy the table formatting 
again (including the column headers). Scroll down at least one row and paste 
the copied data below that second table. At this point, there should be three 
identically labeled tables where the third is blank to be filled later with the 
cumulative sum calculations.   
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11. Calculate the cumulative percentage 
11.1. To calculate the cumulative sum for each quadrat, work from right to left across 

the row. Add each number in the sequence to the sum of the previous cell on 
the right. Continue summing up this way until you reach the leftmost cell (the 
first value). 

11.1.1. Use the following table below to follow the process.  
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11.1.2. Scroll along the top row to the last column header (the end of the TRI 
values). In this example, the end is column O.  

11.1.3. To populate the third table, begin at the end of column O. Starting with 
quadrat rf1-q1-ct (row 46) cell O46. Used the formula “= (select cell #)”, 
where cell# corresponds to adjusted value from the same quadrat cell in 
the second table. Essentially, O46 = the same value as O34. 

11.1.4. Drag that formula down column O to apply to other row of quadrats 
below it.  

11.1.5. In the cell to the left of O46 (the next leftmost cell) or N46 follow this 
convention “= cell> + cell #”. Where cell> is the value of the previous 
rightmost cell (O46) and cell# is the adjusted equivalent to N46 on the 
second table (N34).  

11.1.6. Drag that formula down for all the remaining rows where you have 
quadrat data. 

11.1.7. Repeat for all quadrats.  

 

N46 value = O46 + N34 value 

M46 value = N46 cumulative value + M34 value 

L46 value = M46 cumulative value + L34 

K46 = L46 cumulative value + K34 and so on…. 

 

11.2. Once the entire quadrat (or row) is completed, the leftmost value should have a 
cell value of 0.9999 or 1 or really close to 1. If it doesn’t, the calculations might 
be off. 

  

 Adjusted values 
(second table) 

 Cumulative values  (third 
table) 

   =O46+N34 
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11.3. Now continue setting up the final table with the remainder of formulas needed 
for analysis. 

11.4. Add 2 new columns next to insitu_per_cov on the left-hand side of the table 
and name them:  est_per_cov (calculates a TRI-based percent cover estimate 
from drone products), and sq_err (calculates the difference squared between 
in-situ and estimated percent cover values). 

 

 
 

      
11.5. On the sq_err column add a new field on the cell below the final quadrat row. 

Label it “SSE” 
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11.6. Add a final field label on the cell next to SEE and below the last quadrat label: 
name it “sum_tri_select”. This value will be used when running the solver tool 
and will define the binary output constraints needed.  

11.7. For each of the newly added fields, refer to the following formulas (four of 
them) to calculate values in their respective cells and rows in the third table. 

11.8. Sum_TRI_Select  = sum(binomial range) 

11.8.1. To the right of the cell labeled “Sum_TRI_select”, add a row of 0’s 
spanning the width of the entire table (e.g., from the first TRI value to 
the last in the table) (see example below). Replace the first ‘0’ in the 
row with a ‘1’. There can only be a single 1 in the sequence.  

 
 

11.8.2. Sum the binomial row (the newly added row of 0s and 1) in the cell 
below “sum_tri_select”. Use formula “=sum(range)’.  This should equal 
to 1. 

 

 

 
 

11.9. est_per_cov = SUMPRODUCT (first array, second array) 

11.9.1. The first array in the formula is the entire row of cumulative 
tabulated area values for a quadrat. Select the entire row of values 
for that quadrat.  

11.9.2. The second array in the formula is the binomial selection of 
sum_tri_Select (the entire row of 0’s and 1).  
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Note, the “$” embedded before the row entry in the second array. Putting 1 
for the second array (part of formula after the comma) will not work. The 
formula requires an array, and it would give an error if only a single digit 
number is included.  

11.9.3. Drag the formulas down for all the remaining rows (quadrat cells). 

 
 

11.10. Sq_err = ((insitu_percov) – (est_per_cov))2  

11.10.1. Type this formula in the first cell under the “Squared_error” heading. 
Drag the formula down for all of the remaining rows with quadrat 
data. In the example below, the sq_err formula for row D53 (quadrat 
r1-ex-1o) is “=((B53)-(C53))^2”. 

 
11.11. SSE = SUM(sq_err column) 

11.11.1. SSE (or sum of squared error) calculates the sum of squared errors 
by summing all the values in the sq_err column. In figure this is equal 
to SUM (D53:D61). 

12.  Solver tool  
The Solver tool will be used to estimate percent cover and minimize the sum of squared errors, 
and ultimately determine the minimum TRI threshold where 3D shell/live oyster was detected 
in each quadrat. These estimates will be compared with in-situ percent cover estimates.   

12.1. Add the ‘Solver’ data analysis tool as an excel add-in function.  

12.1.1. Go to the File tab. Click on Options. 
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12.1.2. Select Add-ins. Choose Solver Add-in from the Add-ins tab. 

 
12.1.3. Click on Go. The Add-ins window pops up. 

12.1.4. Select the Solver Add-in checkbox and click OK. 

12.1.5. After you load the Solver Add-in, the Solver command is available in 
the Analysis group on the Data tab. 

 

 
 

12.2. Click the Data tab → Solver (typically to the far right of the Data ribbon in the 
Analyze section). In the Solver Parameters pop-up, enter the following: 

12.2.1. Set Objectives: Select the cell where you calculate the sum of squared 
errors (SSE). 

12.2.2. To: “Min” (we want to minimize the sum of squared errors). 

12.2.3. By Changing Variable Cells: Select the row range of 0’s and 1.  

12.3. Add first constraint.  

12.3.1. Subject to the Constraints: Select the Add button found on the right 
side of the pop-up window. 

12.3.2. While in the constraint pop-up, select the cell where Sum_TRI_select 
is calculated (e.g., the cell below “sum_TRI_Select”, where the range 
sum equals 1).  

12.3.3. Select the “=” sign from the middle drop-down menu, type “1” for the 
Constraint, click Add. This constrains the Solver solution such that 
only one TRI threshold value can be identified in the solution.  Press 
“OK”. 
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12.4. Add a second constraint.  

12.4.1. Subject to the Constraints: Click Add.  

12.4.2. In the Add Constraint pop-up, select all the cells with 0’s and 1 (the 
Sum_TRI_select binary range).   

12.4.3. Select “bin” from the middle drop-down menu (for binary), click Add. 
This constrains the solution such that values in that row must remain 
binary (0 or 1). Press “OK”. 

12.5. Check the box for Make Unconstrained Variables Non-Negative. 

12.6. Select a Solving Method: GRG Nonlinear. 

12.7. Click Solve. 

Note, the Solver tool may take a few minutes to run. 

 

 
 

12.8. After the Solver tool is finished, locate the Sum_TRI_select binary row. 
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12.9. Scan that row and find the value of 1 among the 0s. The column where the 1 
is located represents the TRI threshold value that Solver determined 
minimizes the sum of squared errors between in-situ 3D/live oyster cover and 
TRI-based 3D/live oyster cover. 

12.9.1. In column N of the data template, record the TRI threshold value, 
which will be identical for all quadrats on the reef. 

12.9.2. In column O of the data template, copy and paste the values in the 
cells in the threshold TRI value column (each quadrat will have a 
different value). After pasting these values, multiply each one of 
these values by the values in column R (e.g., multiply O2*R2, O3*R3, 
etc.). The final value represents the percentage of live oysters in 
each quadrat after taking into account what percentage of the 
quadrat is covered by oysters versus sediment. 

12.9.2.1. The caption of the screenshot below describes an example. 

12.9.3. In column P of the data template, enter the formula “= R2 – O2” and 
drag the formula down for all rows. This formula subtracts the 
estimated percent cover of live oysters from the estimated total 
percent cover of oysters to determine the estimated percent cover 
of cultch. 

 

In this screenshot, the determined TRI threshold is 40, so 40 would be pasted in 
column M of the data template. Additionally, the values beneath 40, starting with 
0.82118 and ending with 0.80588, would be copy and pasted into column N of the 
data template. Then, these values would be multiplied by each respective value in 
column Q. 
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13.  Create a vertical oyster, cultch, and sediment layers 
To create the following Feature Class layers for vertical oyster shell, cultch, and sediment, steps 
6 and 8 from the Footprint Workflow can be followed (e.g., ‘Raster to Polygon’, ‘Select by 
Attribute’, ‘Dissolve’, ‘Eliminate’, and ‘Calculate Geometry Attributes’). The only difference is 
that the TRI layer created above is combined with the Classified Layer in the Footprint 
Workflow. 

13.1. Go to Geoprocessing Tools, search for and open ‘Raster to Polygon’.  

-Input Raster → Extract_Oyster_Classified_TRI_Combine 
-Field →  TRI_100Int 
-Output →  Oyster_Classified_TRI_Polygon 

13.2. Go to Geoprocessing Tools, search for and open ‘Select Layer By Attribute’. 

-Input Rows →  Oyster_Classified_TRI_Polygon 
-Selection Type →  New Selection 
-Expression →  Where “gridcode” “is greater than or equal to” “TRI value 
from step 11.9”  (e.g.,TRI 40) 

 

 
 

13.3. Go to Geoprocessing Tools, search for and open ‘Dissolve’. 

Input Features →  Oyster_Classified_TRI_Polygon 
Make sure “Use the Selected Records” is toggled on 
Output Feature Class →  VerticalOyster_Classified_Polygon 
Make sure “Create multipart features” is checked 

  

  

40 
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13.4. Go to Geoprocessing Tools, search for and open ‘Eliminate Polygon Part’. 

Input Features →  VerticalOyster_Classified_Polygon 
Output Feature Class→  Vertical_Oyster_Polygon 
Make sure that “Eliminate contained parts only” is checked 
 

 
13.5. Go to Geoprocessing Tools, search for and open ‘Calculate Geometry 

Attributes’. 

Input Features →  Vertical_Oyster_Polygon 
Geometry Attributes →  Shape_Area, Area (geodesic) 
Area Unit →  Square Meters 
Coordinate System →  Use the Coordinates System from the project 
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13.6. To calculate shell culch, follow steps 13.2 to 13.6. The only change to be made 
is in step 13.2 where you replace “greater than or equal to” to “less than”. 
This will select all classified oysters below the calculated TRI value for vertical 
oysters. 

13.7. To calculate sediment, follow steps 7.3 and 7.4 to extract sediment by mask 
from the combined raster. Change the class code to sediment on step 7.3. 

Expression → where Classified Raster “is equal to” class code for 
Sediment. 

13.8. To continue calculations for sediment, follow step 13.1, then steps 13.3-13.5 
using the extracted raster created in the previous step (skip step 13.2). The 
order of tools used will be: Raster to Polygon → Dissolve → Eliminate Polygon 
Part → Calculate Geometry Attributes.   

 

 
Progress check:  3 outputs                                                                                                        

Vertical_oyster_polygon.shp 
Cultch_polygon.shp 
Sediment_polygon.shp 
 

 

14.  Exporting ArcGIS project (.ppkx) 
14.1. Share tab  Project (left side).  
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14.1.1. Start packaging = “Save project to file”. 

14.1.2. Item details = change the file location and name, as appropriate.  

- If the projects are reef-specific, save the files as: 
xxx_zz_mmddyy_percov.ppkx, where xxx = reserve initials, zz = reef 
initials, mmddyy = date sampled (e.g., noc_nr_061323_percov.ppkx) 

- If the projects are workflow-specific, and contain all reefs, save the 
file as: xxx_allreefs_yyyy_percov.ppkx, where xxx = reserve initials, 
yyyy = year sampled (e.g., noc_allreefs_2023_percov.ppkx). 

- For the experimental reefs, save the files in one of the two formats 
listed above, and add ‘_experiment.ppkx’ at the end of the name 
(e.g., noc_nr_030724_percov_experiment.ppkx). 

14.1.3. Select the checkbox for “Share outside of organization”. Make sure 
all other checkboxes are unselected. 
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15.  Appendix 
Summary of formulas 

TRI = ((Focal_Mean)-(Focal_Min))/((Focal_Max)-(Focal_Min)) 

est_per_cov = SUMPRODUCT (first array, second array) 

Sq_err = ((insitu_percov) – (est_per_cov))2 

SSE =SUM(sq_err column) 

Rowsum = sum(select quadrat row) 

Adjusted cell value =(Cell area value) / (total row rum area) 

 

TRI Manual method 

1. Open the excel file generated in step # 5. 

2. Follow the sample table below for reference to complete the following steps. 

 A B C D E F G 

1 Quad in-situ_ 
per_cov 

est_per_co
v 

TRI_22 TRI_23 TRI_24 TRI_25 

2 SR7_Q1 0.17  0 0 0 0.00025 

3 SR7_Q2 0.31  0 0.00012 0 0 

4 SR7_Q3 0.26  0.0001
2 

0 0.00025 0 

 

3. Insert two columns after column A and name them in-situ_per_cov and est_per_cov, for 
in-situ percent cover and estimated percent cover (from drone products).  

4. Import your in-situ percent cover data (as a decimal) estimated for 3d/live oysters and 
make sure you enter percent covers associated with the correct quadrat. 

5. Place the equation =sum() into the est_per_cov column.  

6. Working from the highest TRI number (far right of the table). Calculate the Sum working 
right to left in the table for each row until the Sum from the TRI values is close to the in-
situ_per_cov value for that row. Highlight the last cell from right to left on the table that 
gives the sum close to the in-situ number.  

 



107 
 

 
 

7. Now calculate the average TRI value from the highlighted cell place holders. Sum all the 
TRI numbers then divide by the number of quadrats. 

8. Using the example table above. Equation 
(51+52+53+53+53+54+56+57+58+59+60)/11=55 

9. I dropped the two outlier TRI values that have a percent cover of 0%. 

10. Using the TRI value from the equation (55 from example) the percent cover vertical 
oyster layer will be created. 

 

VRM (Vector Ruggedness Measure) Process 

To use the VRM tool, you will need to install the ArcHydro toolbox into ArcPro Desktop. 

 

1. Set up the VRM toolbox 

1.1. Download : Arc Hydro Downloads for ArcMap & ArcGIS Pro (esri.com) 

https://www.esri.com/en-us/industries/water-resources/arc-hydro/downloads?rsource=https%3A%2F%2Fdownloads.esri.com%2Farchydro%2Farchydro%2FSetup%2FPro%2F
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2. To add the downloaded file into ArcGIS Desktop, select “settings” on the main ArcGIS Pro 

desktop page. Then select, “Add-in Manager”.  

 

 
 
The file is an “.msi” extension file that needs to be added to the software through the add-
in Manager”. 

2.1. Load the .msi archydro file through the add-in manager. After it is properly 
installed it should look like the figure above.  

3. Open your ArcGIS project and search in the geoprocessing toolbox for “archydro” or VRM to 
confirm it is there. The tool now exists within the geoprocessing toolbox. 
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 Run the ArcHydro VRM tool for your RMSE adjusted digital surface model (DSM). You are using 
the same DSM that was used for the TRI process.  

 

4. Open the VRM tool and select the proper parameters.  

Input � DSM 
Neighborhood distance � a value preferred for analysis based on the pixel size and 
image resolution 
Window size � default is 3 (Note, a larger window size can be useful but often causes a 
smoothing effect on the landscape). 
Output � VRM raster data set that has a dimensionless ruggedness value between 0 
(flat) and 1 (most rugged). Typical values for natural terrains range between 0 and 0.5, 
with rugged landscape defined to be greater than 0.02. 

 
 

5. Turn VRM into degrees 

5.1. Go to Geoprocessing Tools, search for and open Raster Calculator and calculate 
formula: (SquareRoot (“VRM_raster” * 2)) * (57.3) 

-Input  VRM_raster  
-Output Raster → VRM_degrees 
-Click Run. 

6. Turn VRM into integer form  

6.1. Go to Geoprocessing Tools, search for and open ‘Int’ (this creates an Integer 
Raster). 

-Input Raster → VRM_degrees 
-Output Raster → VRM_Int 
-Click Run. 

7. Tabulate area following the same process used for TRI. 

 
 
Progress check: 4 outputs                                                                                                        
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VRM.tif 
VRMdegrees.tif 
VRMdegrees_INT.tif 
Tabulated_VRM.xls 
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VI. Oyster Shell Volumetric Change Workflow 
 
Workflow lead and contact: Camille Elfstrom (camille.steenrod@noaa.gov) 
 
Overview 

1. Introduction 
2. Preparing data and setting up data template 
3. Subtracting DSM rasters 
4. Create quadrat polygon layer 
5. Clipping raster 
6. Incorporating limit of detection values (LoD) 
7. Calculating volumetric change at the quadrat-level 
8. Finish filling out data template and export ArcGIS project 

 
Introduction 
This workflow was developed to detect volumetric change following excavation of oysters from 
the reef using pre- and post-extraction products (i.e., orthomosaics and Digital Surface Models 
(DSMs)). Only proceed with this workflow if you have completed the Oyster Reef Elevation and 
Elevation Change Workflow, and produced corrected pre- and post-extraction DSMs.  
This workflow is specific to the quadrat-level, so that it can be compared to volumetric change 
measured in-situ. If interested, this workflow can also be used at the reef scale. Simply create a 
polygon feature class of the general reef area, rather than a polygon feature class of the 
quadrats.  
 

Volumetric change = ∑ (+LoDelev ≥ (Post DSM – Pre DSM) ≤ -LoDelev)) * cell size X * cell size Y 
 

Inputs: 
- Corrected DSMs (pre- and post-extraction). 
- Orthomosaics (pre- and post-extraction). 
- RTK coordinates for quadrat corners. 
- Values of volumetric change measured in situ (if comparing to GIS-generated values) 

(\in-situ_data_spreadsheets: “raw_data_density_volume_weight”). 
- Values of limit of detection as calculated in Excel spreadsheet 

(\imagery_data_spreadsheets: “workflow_elevation_database”). 
 
Output: 



112 
 

- Excel spreadsheet with volumetric results for all reefs (\imagery_data_spreadsheets: 
“workflow_volume_database”). 

 
Flow chart overview of workflow: 

 
 
*General note: If a tool fails, it’s possible that the name of the product can only be 9 or 13 
characters. Try shortening the name or output location and run the tool again. 
 
**Reminder: Please keep track of how long this workflow takes to complete, as you will 
record this information in the Excel spreadsheet. 
 

1. Preparing data and setting up data template 
1.1. Setting up volumetric change Excel data template 

a. Open the “workflow_volume_database” Excel spreadsheet 
(\imagery_data_spreadsheets). 

→ Row 2 can be deleted; it is example data from North Carolina. 
b. In columns A-H, fill in the site/reef metadata, which can be copied and pasted from 

the in-situ data templates. 
→ Column header definitions are defined in the “metadata” tab. 
→ Note, make sure to create the same number of rows as there are quadrats 

(e.g., if six quadrats were excavated at Reef 1, there will be six rows of data in 
the spreadsheet for said reef). 

c. In column I, enter the name of the ArcGIS project. 
d. In column J, enter whether the analysis was performed for the harvest or control 

plot for the experimental reefs, OR put “NA” for non-experimental reefs. 

 
1.2. Determine project structure 

a. Prior to starting, decide whether all sampled reefs will be housed in the same 
ArcGIS project (e.g., each reef will have a separate Map tab), or if each ArcGIS 
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project will house an individual reef. Note, your decision will affect the naming 
convention of the final exported ArcGIS project(s), specified at the end of the 
workflow. 

 
1.3. Create a new ArcGIS Pro file and add files 

a. Open ArcGIS Pro and create a new map (check the box for “Create a folder for this 
project”). 

b. Import .csv file with RTK coordinates for quadrats (xyz data for each point). 
c. Import corrected pre- and post-extraction DSMs created using the Oyster Reef 

Elevation and Elevation Change Workflow. 
d. Import pre- and post-excavation orthomosaics. 

 
1.4. Convert RTK coordinates XY data 

a. Right click on the .csv file added in the Table of Contents (under “Standalone 
Tables”) → Create Points from Table → XY Table to Point (Fig. 1). 

→ X Field = column with X coordinates (e.g., easting) in .csv. 
→ Y Field = column with Y coordinates (e.g., northing) in .csv. 
→ Z field = column with Z coordinates (e.g., elevation) in .csv. 
→ Coordinate system = click and drag (or select from dropdown menu) a 

DSM/orthomosaic/other file with coordinate system of interest (e.g., NAD 
1983 2011 UTM Zone 18N, NAVD88). 

 
Figure 1. Screenshot of a pre-extraction orthomosaic, with the coordinates of the 
corners of six RTK quadrats converted to XY data (highlighted in turquoise). 
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2. Subtracting DSM rasters 
2.1. Subtracting post- minus pre-extraction corrected DSMs  

a. Analysis tab (top ribbon) → Tools → Minus (Fig. 2). 
→ Input before raster surface = Corrected post-extraction DSM.  
→ Input after raster surface = Corrected pre-extraction DSM.  
→ Output raster = Minus tool results (e.g., “[reef-initials]_minus_popr”). 

-  Note, the difference raster in units of meters.  
2.2. Entering data into date template 

a. In column K of the template, enter which rasters were subtracted from one 
another in step 2.1 (e.g., “post_pre” for all non-experimental reefs, and “post_pre” 
OR “add_post” for experimental reefs). 

b. Right click on the clipped “minus” raster product (e.g., “[reef-
initials]_minus_popr_clip”) layer in ArcGIS → Properties → Source → Raster 
information → Cell Size X and Cell Size Y. 

c. In columns X and Y of the template, record these cell size values (units should be in 
meters). All quadrats on the reef will have the same cell size X and Y, so copy and 
paste these values into all quadrat rows. 

 

 
Figure 2. Screenshot of post – pre corrected DSMs using the Minus tool, with the 
coordinates of the corners of six RTK quadrats (highlighted in turquoise). Note, the 
difference anomalies (black and white colors) are concentrated over water.  
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3. Create quadrat polygon layer 
3.1. Creating polygon layer feature class for quadrats 

a. Analysis tab → Tools → Create Feature Class. 
→ Input Parameters 

-  Feature class name = name of output (e.g., “[reef-
initials]_plot_polygons”). 

-  Geometry type = polygon. 
-  Template dataset = pre- or post-excavation DSM that has the coordinate 

system of interest. 
-  Has Z = Same as the template feature class. 
-  Coordinate system = pre- or post-excavation DSM that has the coordinate 

system of interest. 
b. Left click on the polygon feature class created in the Table of Contents and make 

sure the box for this layer is checked. 
c. Right click on the layer and open the attribute table. 

→ Field: Add. 
→ Field Name: plot_name. 

-  Alias: plot_name. 
-  Data Type: text. 

→ Click Save on the top ribbon. 
→ Close the “Fields” tab. 

d. Edit tab (top ribbon) → Edit → Create → Choose the polygon feature class just 
created under the “Create Features” window on the right side (e.g., “[reef-
initials]_plot_polygons”).  

e. Right click on the RTK coordinates layer → Open attribute table. 
f. Find the points associated with quad 1 and select these points in the attribute 

table by clicking and dragging the rows of interest (will be highlighted in turquoise 
when selected) → right click on one of the highlighted rows → click “Zoom to”.  

g. Right click on one of the quadrat corner points and choose “Snap to feature” → 
“Vertex”. 

h. Repeat this snapping process for each corner of the plot. 
i. Double click the last corner to close the polygon (Fig. 3).  

→ Make sure no PVC is included in the polygon if quadrats were left on the reef 
during the flights (use BOTH pre- and post-extraction orthomosaics to check). 

j. Edit tab → Edit → Attributes.  
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k. In the panel that opens on the right, rename the “plot_name” field created in the 
previous step; make sure the name matches whichever quadrat you are working 
on (e.g., if you created the polygon around the RTK coordinates for quadrat 1, then 
the plot_name field would be labeled as “quad_1”). 

→ Repeat this step for each plot, going in order of what the plots were named 
(quad 1 first, quad 2 second, etc.). 

l. Save edits. 
m. Click “Edit” in the top ribbon to end the editing process. 

 
Figure 3. Screenshot of an example quadrat polygon (1/16 m2). Note that any areas with 
PVC in the imagery (in this case the PVC quadrat) were excluded when creating the 
polygon.  
 

4. Clipping raster 
4.1. Clipping DSMs to the plot feature class layer 

a. Analysis tab → Tools → Clip raster (Fig. 4). 
→ Input raster = Minus tool DSM produced in step 3 (e.g., “[reef-

initials]_minus_popr”). 

→ Output raster = quadrat polygon shapefile created in step 4 (e.g., “[reef-
initials]_plot_polygons”). 

→ Check the box for “Use input features for clipping geometry”. 
→ Output raster = Clipped post-DSM – pre-DSM (e.g., “[reef-

initials]_minus_popr_clip”). 
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Figure 4. Screenshot of an example of the subtracted raster created in step 2 clipped to 
the plot-level in step 4. 

5. Incorporating limit of detection values (LoD) 
5.1. Calculating Elevation Change LoD 

a. If you calculated LoD as part of the Oyster Reef Elevation and Elevation Change 
Workflow, skip to step 7 below.     

b. Elevation change limit of detection calculation based on: Lane et al. 2003 and 
applied in James et al. 2017 and Dale et al. 2020. Formula for elevation change 
limit of detection (LoD) when comparing two DSMs: LoDelev = t * √(RMSE of DSM12 
+ RMSE of DSM22) 

→ where t is the t distribution value at a desired level of confidence (i.e., at 95% 
confidence, t = 1.96) and RMSE of DSM1 and DSM2 are the root mean squared 
errors of the pre- and post-excavation DSMs, respectively.  We will calculate 
LoD at 68% confidence using a t value = 1 

c. Open the ‘workflow_elevation_database’ data template (or the experiment version 
if entering data from the manipulative experiment). Both are available at the 
following path: \imagery_data_spreadsheets. Enter the required data in the ‘RMSE’ 
and ‘yint_slope values’ tabs based on outputs generated in above sections of the 
workflow. Column header definitions are defined in the ‘metadata’ tab. 

→ Note, the data templates have an example from one reef in North Carolina. 
Delete this entry after entering your data and copying the formulas.  

d. In columns I and J of the ‘elevation limit of detection’ tab, re-enter the ‘best’ DSM 
adjustment used for each DSM in the time series (e.g., pre- and post-excavation 
DSMs, respectively). For the experiment, where three DSMs were generated, enter 
the best DSM adjustment for the shell addition DSM in column K.  

https://onlinelibrary.wiley.com/doi/pdf/10.1002/esp.483
https://onlinelibrary.wiley.com/doi/pdf/10.1002/esp.4125
https://www.sciencedirect.com/science/article/pii/S0925857419304197/pdfft?md5=19de8d3f4be207115535111acf8ec429&pid=1-s2.0-S0925857419304197-main.pdf
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e. In column K (or L for the experiment), enter a value of 1 for each row containing 
data. The 1 represents the t distribution value associated with 68% confidence. 

f. In column L (or M for the experiment), calculate elevation change LoD.  
g. The excel formula for calculating LoDelev for pre vs post excavation based on ‘best’ 

DSM using y-intercept and slope adjustment is: 
=$K3*SQRT(RMSE!M3^2+RMSE!P3^2). 

h. Repeat the calculation, making sure to reference the correct RMSE based on the 
‘best’ DSM adjustment for the remaining reefs in your dataset.  

→ Note, for the experiment, an additional column of LoD calculations is 
necessary to account for the post-excavation vs shell addition DSMs. The 
format of the excel formula is the same as above with different RMSE’s 
referenced.  

i. In column N (or O and P for the experiment), convert LoD calculations to meters by 
dividing LoD values in column L (or columns M and N for the experiment) by 100. 
These are the values you will use in step 7 when running the raster calculator.   

 
5.2. Run the Raster Calculator tool 

a. Analysis tab → Tools → Raster Calculator (Fig. 5). 
→ Map algebra expression = Con("[reef-initials]_minus_popr_clip" <= [negative 

LoD value from Excel], "[reef-initials]_minus_popr_clip", Con(("[reef-
initials]_minus_popr_clip" >= [positive LoD value from Excel]), "[reef-
initials]_minus_popr_clip”)). 

-  For our purposes, we will use the LoD value associated with a 68% 
confidence interval. Units should be in meters.  

-  For example, if the elevation change LoD for pre- vs post-excavation 
DSMs is 0.020494523, then the raster calculator formula is  
Con("pi_minus_popr_clip" <= -0.020494523, "pi_minus_popr_clip", 
Con(("pi_minus_popr_clip" >= 0.020494523), "pi_minus_popr_clip")). 

→ Output raster = Subtracted raster with LoD threshold (e.g., “[reef-
initials]_popr_con68”). 

-  Note, the units of the subtracted raster are in meters.  
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Figure 5. Screenshot of an example of the formula to be used in the raster 
calculator. 

 
b. Right click on the new layer in Table of Contents → Create chart → Histogram (Fig. 

6). 
→ Make sure that there are no cells (i.e., count = 0) between the negative LoD 

value and positive LoD value. 
-  Note, ArcGIS automatically generates the range of values in the 

histogram, so it may appear as though some cells that fall outside of the 
range are included. In this example, since -0.020 is less than -0.016 and 
greater than -0.022, a few cells appear to be in the bar labeled -0.016. 

-  If you want to double check that the tool ran correctly, simply expand the 
layer in the Table of Contents, and it will show you the minimum and 
maximum raster cell value. 
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Figure 6. Frequency distribution histogram of cells in newly created raster with 68% 
confidence interval LoD values only (i.e., cells > 0.020494523 and  
cells < -0.020494523).  

6. Calculating volumetric change at the quadrat-level 
6.1. Run the Zonal Statistics as Table tool and export results to Excel  

a. Analysis tab → Tools → Zonal Statistics as Table. 
→ Input raster = Feature class layer with plot polygons. 
→ Zone field = OBJECTID. 
→ Input value raster = Minus tool results produced in step 6 (e.g., “[reef-

initials]_popr_con68”). 
→ Output table = Zonal statistics table (e.g., “[reef-initials]_zonal_plots_con68”). 
→ Leave the other settings as the default options. 
→ Note, units in the table are as follows: area = m2, all other columns in meters.  

b. Right click on the table added to the Standalone Tables in the Table of Contents 
(Fig. 7). 

→ Click on the three horizontal bars in the top right corner of the table → Export. 
-  Input table = Table created using the Zonal Statistics as Table tool (e.g., 

“[reef-initials]_zonal_plots_con68”). 
-  Output table = Table exported to Excel (e.g., “[reef-

initials]_zonal_plots_con68_ExportTable.csv”). 
⇒ Manually add .csv at the end of the name. 
⇒ Do NOT save the output to the geodatabase (.gbd). 

 
Figure 7. Screenshot of an example zonal statistics table, with data on all six quadrats; 
row 1 = data for quad 1, etc. 

 
 

6.2. Calculate volumetric change in Excel 
a. Open the exported table in Excel. 
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b. Copy all cells of data from this spreadsheet, and paste them in columns L-W of the 
data template spreadsheet under the appropriate headings. 

c. In column Z of the data template, add a formula which multiplies the (SUM) * 
(cell_size_X) * (cell_size_Y) (e.g., U2 * X2 * Y2). 

→ Note, units are in m3 (1 m3 = 1000 Liters). 
d. Drag this formula to calculate volumetric change in all rows (i.e., quadrats) of the 

table (Fig. 8). 
→ Note, rows for some quadrats may be missing if no cells exceed the positive 

and negative LoD threshold. In this case, you can insert a row to add the 
quadrat and the Sum_x_area value for that quadrat should be equal to 0.  

 
Figure 8. Screenshot of the data template with the copied and pasted values from the zonal 
statistics table for a reef with six quadrats, plus the cell_size_X and cell_size_Y data added, and 
the Sum_x_area column calculated. 
 

7. Finish filling out data template and export ArcGIS project 
7.1. Finish filling out the data template to finish filling in data 

a. In column AA and AB, record (in minutes) how long the workflow took to complete, 
and the last name of the workflow user.  

→ Note, time recorded will be reef-specific, not quadrat-specific. Please record 
the time it took in the first row of data for each reef, and fill the remaining 
rows associated with that reef with zeros (e.g., if it took 60 minutes to 
complete the workflow for Reef 1, and there are six quadrats (rows) associated 
with Reef 1, then fill row 2 with a ‘60’ and rows 3-7 with ‘0’ in column Z).  

b. When saving the file, add the reserve’s initials at the start of the file name (e.g., 
“noc_workflow_vol_change_database”).  

 
7.2. Exporting ArcGIS project (.ppkx) 

a. Share tab → Project (left side) (Fig. 10). 
→ Start packaging = “Save package to file”. 
→ Item details = change the file location and name, as appropriate. 
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-  If the projects are reef-specific, save the files as: 
xxx_zz_mmddyy_volume.ppkx, where xxx = reserve initials, zz = reef 
initials, mmddyy = date sampled (e.g., noc_nr_061323_volume.ppkx). 

-  If the projects are workflow-specific, and contain all reefs, save the file 
as: xxx_allreefs_yyyy_volume.ppkx, where xxx = reserve initials, yyyy = 
year sampled (e.g., noc_allreefs_2023_volume.ppkx). 

-  For the experimental reefs, save the files in one of the two formats listed 
above, and add ‘_experiment.ppkx’ at the end of the name (e.g., 
noc_nr_030724_volume_experiment.ppkx). 

→ Select the checkbox for “Share outside of organization”. Make sure all other 
checkboxes are unselected.  

 
Figure 10. Screenshot of the Project Package window, with the appropriate selections 
chosen and file name edited to match the instructions listed above.  
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VII. Oyster Density Workflow 
 
Workflow leads and contacts: Brandon Puckett (brandon.puckett@noaa.gov) and Dan Bowling 
(djbowlin@ncsu.edu) 
 

Overview 
1. Start up 
2. Develop density model from site specific variables 
3. Extract explanatory variables from rasters 
4. Generate density predictions using generalized additive model  
5. Generate estimated density map layer 
6. Appendix 

1. Start up 
Determine ArcGIS project structure–Prior to starting, decide whether all sampled reefs will be 
housed in the same ArcGIS project (e.g., each reef will have a separate Map tab), or if each 
ArcGIS project will house an individual reef. Note, your decision will affect the naming 
convention of the final exported ArcGIS project(s) specified at the end of the workflow. 
 
Create a project folder to house your density project, dataset, and ArcGIS Pro. It is 
recommended to have a separate ArcGIS Pro geodatabase for this workflow. 
 
*This is a good time to create a “Data_Inputs” folder and add copies of the original study site 
orthomosaics, corrected Digital Elevation Models/Digital Surface Models (hereafter referred to 
as a DSM), and RTK data of corners of quadrats used for in-situ sampling. 
Open ArcGIS Pro and create a new project, referencing the project folder created in the 
previous step (“Create a folder for this project’ option can be unchecked as the project folder 
has already been made). [suggested naming convention: “AbbreviatedSite 
Name_densityYear_UserInitials”, example: pi_density23_DB] 
 
Click Add Data Load: 

1) Corrected DEM raster data from before any in-situ excavation 
2) Orthomosaic raster data from before any in-situ excavation 
3) RTK data (this will be used check the raster data layers and create polygon reef 

sample areas) 
 
Corrected and quality DSMs are recommended for each project, follow step by step guide in 
Oyster Reef Elevation and Elevation Change Workflow. [Optional: RTK surveyed ground control 

mailto:brandon.puckett@noaa.gov
mailto:djbowlin@ncsu.edu


124 
 

points (GCP) and Checkpoint points can be added to verify layer accuracy and that the project is 
working with the corrected DSM. This can be done by adding a the RTK .csv file, right clicking on 
the newly added table in the Contents pane, select ‘Create Points From Table’, click ‘XY Table 
To Point’, enter an appropriate name for RTK data, set X to Easting, Y to Northing, and Z to 
Elevation (this can be checked for accuracy by selecting the table and opening it from the 
Contents pane). Make sure the coordinate system matches the ortho! Once added, make sure 
the points are properly aligned with GCPs and Checkpoints and the DMS with the ortho.] 

2. Develop density model from site specific variables 
 
-Display RTK data as points 

-*If RTK data is in table or .csv file format: 
● Make sure the RTK data has been added to the map’s Contents pane 
● Right click on the table data in the Contents pane 
● Select ‘Create Points From Table’ 
● Click ‘XY Table To Point’ 
● Enter an appropriate name for RTK data, set X to Easting, Y to Northing, 

and Z to Elevation 
 
-Create Sample Quadrat Polygons 
-*Inspect the RTK points that correspond with the excavated sample quadrats 
-*Click Analysis � Tools � Create Feature Class (Data Management Tools) 
  
Feature Class Location: Select project geodatabase 
 Feature Class Name: Site_quad_polygon 
 Geometry Type: Polygon 
 Coordinate System: Set to site DEM layer 
 *Leave remaining options as default 
 *Click Run 
*Navigate to the project geodatabase in the catalog pane and add the feature class you created 
to the current map 
*On the ribbon, click Edit, Create icon, select Site_quad_polygon 
*In the order of the quadrats, zoom all the way into the RTK quadrat corner points tool and 
create a feature to represent each quadrat 
 -enable Snapping (within edit ribbon) to automatically “snap” to the RTK points and  

more easily generate a polygon using the quadrat corners 
*Double clicking on the 4th corner of a quadrat will close the feature and allow you to move on 
the next sample quadrat 
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*IMPORTANT – be sure to modify the polygons as needed to avoid inaccuracies (i.e., PVC 
quadrats left on the reef. A fix to this would be adjusting corner points to fall just inside to 
avoid inaccuracies in digital sampling.) 
*Inaccurate or unwanted points can be deleted by hovering the cursor over the point, right 
clicking, and selecting ‘Delete Vertex’ 
*Created features can be modified by clicking the Modify icon on the ribbon 

*Once all sample quadrat polygons have been created, click the  icon and then click the  

 icon under the Edit tab once finished with edits. 
*Open the quadrat polygon attribute table 

-Add column to attribute table, name it ‘quadrat_id’ 
-Specify type as text, add quadrat names in each row (e.g., quadrat_1, quadrat_2, etc) 
-Make sure the order of the quadrat name labels are in the same order as the polygons 
were delineated above. 
-Save all Edits 

3. Extract explanatory variables from rasters 
3.1. Run zonal statistics on the RGB Orthomosaic 
 -Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: Site_quad_polygon 
  -Zone Field: quadrat_id) 
  -Input Value Raster: Selected site RGB Orthomosaic 
   -Make sure this is the pre-excavation RGB orthomosaic 
  -Output Table: ZonalSt_Site_Year_RGB_Ortho 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  -*Click Run 

*Open ZonalSt_Site_Year_Ortho table 
 

-Copy the values from ‘Count’ to ‘Pct90’ and paste in columns N to AD  of the 
workflow_density_database.xlsx (\imagery_data_spreadsheets). 

-In column AE of the ***_workflow_density_database.xlsx, standardize ‘Sum’ values in 
column U of the data template by quadrat area in column O of the data template using 
the following formula: ‘=if(U2=””, ””, U2/O2)’. Drag the formula down for the remaining 
quadrat (row) entries.  
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3.2. Iso Cluster unsupervised classification 
3.2.1. Clip RGB Orthomosaic to reef polygon 
 -Generate reef polygon that excludes most water  
  -Note, this is intended to be a quick, crude outline of the reef 
  -Analysis  Tools  Create Feature Class (Data Management Tools) 

 -Feature Class Location: Select project geodatabase 
-Feature Class Name: Site_Reef_Boundary_Layer (where ‘Site’ should be 
changed to the site abbreviation) 

 -Geometry Type: Polygon 
-Template Datasets: leave blanks 
-OID Type: select same as template 

 -Has M: No 
-Has Z: No 

 -Coordinate System: Set to site orthomosaic layer 
 -Feature Class Alias: leave blank 

-*Click Run 
*Select Edit from the ribbon, click the ‘Create’ icon. In the Create Features 
pane, select the Site_Reef_Boundary_Layer and select your preferred drawing 
tool. The Line tool is sufficient given that the boundary is supposed to be a 
quick outline of the reef. Create a feature to represent the site boundary 
*Once created, this feature can be modified by clicking the Modify icon on the 
ribbon 
*Click Save under the Edit tab once finished with edits. 

 
 -Clip RGB orthomosaic to reef boundary layer 
  -Analysis  Tools  Clip Raster (Data Management Tools) 

-Input Raster: Selected site RGB Orthomosaic 
    -Make sure this is the pre-excavation RGB orthomosaic 
   -Output Extent:  Site_Reef_Boundary_Layer 

-Output Raster Dataset: Site_RGB_Ortho_Reef_Clip 
-Make sure output raster dataset is within the project 

geodatabase 
-Check ‘Use Input Features for Clipping Geometry’ 
-NoData Value: 999  
-*Click Run 

 
3.2.2. Generate Iso Cluster unsupervised classification 

-Analysis → Tools → Iso Cluster Unsupervised Classification (Spatial Analyst Tools)  
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-Input raster bands:  Site_RGB_Ortho_Reef_Clip 
-Number of classes: 3 

-Note, the 3 classes correspond to dark, intermediate, and light colored 
pixels 

-Output classified raster: RGB_Ortho_IsoClust_Site_Year 
 -Make sure this is saved to the appropriate (e.g., site) geodatabase 
-Minimum class size: 20 
-Sample interval: 20 
 -Note, minimum class size and sample interval values are based on  
 Windle et al. 2022. 
-Output signature file: leave blank (this is an optional input) 
-Click Run 

-Note values of 1 = dark pixels, 2 = intermediate pixels, and 3= light pixels.  
 
3.2.3.  Run zonal statistics on iso cluster raster 

-Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
 -Input Raster or Feature Zone Data: Site_quad_polygon 
 -Zone Field: quadrat_id 
 -Input Value Raster: RGB_Ortho_IsoClust_Site_Year 
 -Output Table: ZonalSt_Site_Year_RGB_IsoClust 
 *Check ‘Ignore NoData in Calculations’ 
 -Statistics Type: All 
 -Percentile Values: 90 
 -*Click Run 
*Open ZonalSt_Site_Year_RGB_IsoClust table 

-Copy the values from ‘Count’ to ‘Pct90’ and paste in columns AF to AV of the 
workflow_density_database.xlsx (\imagery_data_spreadsheets). 

-In column AW of the workflow_density_database.xlsx, standardize ‘Sum’ values in 
column AM of the data template by quadrat area in column AG of the data template 
using the following formula: ‘=if(AM2=””, “”, AM2/AG2)’. Drag the formula down for the 
remaining quadrat (row) entries. 
-In column AX, calculate the count of dark (1) pixels:  

‘=IF($AP2="", "", IF(AND($AO2=1,$AR2=1),$AF2, IF($AO2=$AR2, 0, 
IF($AO2=1,$AP2,IF($AR2=1,$AS2,$AF2-SUM($AP2,$AS2))))))’ 
-In column AY, calculate the count of intermediate (2) pixels:  
 ‘=IF($AP2="", "", IF(AND($AO2=2,$AR2=2),$AF2, IF($AP2=$AS2, 0, 
IF($AO2=2,$AP2,IF($AR2=2,$AS2,$AF2-SUM($AP2,$AS2))))))’ 
-In column AZ,calculate the count of light (3) pixels:  
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‘=IF($AP2="", "", IF(AND($AO2=3,$AR2=3),$AF2, IF($AP2=$AS2, 0, 
IF($AO2=3,$AP2,IF($AR2=3,$AS2,$AF2-SUM($AP2,$AS2))))))’    
-In column BA, calculate the proportion of dark (1) pixels: ‘=if(AX2=””,””, AX2/$AF2)’ 
-In column BB, calculate the proportion of intermediate (2) pixels: ‘=if(AY2=””, “”, 
AY2/$AF2)’  
-In column BC, calculate the proportion of light (3) pixels: ‘=if(AZ2=””, “”, AZ2/$AF2)’ 

 -*Drag the formulas down for the remaining quadrat (row) entries. 
 
3.3. Run zonal statistics on the DEM 
 -Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: Site_quad_polygon 
  -Zone Field:  quadrat_id 
  -Input Value Raster: Selected site corrected DEM 
   -Make sure this is the pre-excavation AND corrected DEM 
  -Output Table: ZonalSt_Site_Year_DEM 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  -*Click Run 

*Open ZonalSt_Site_Year_DEM table 
-Copy the values from ‘Count’ to ‘Pct90’ and paste in column BD to BM of the 
workflow_density_database.xlsx (\imagery_data_spreadsheets). 

-In column BN of the ***_workflow_density_database.xlsx, standardize ‘Sum’ values in 
column BK of the data template by quadrat area in column BE of the data template 
using the following formula: ‘=IF(BK2 = "", "", BK2/BE2)’. Drag the formula down for the 
remaining quadrat (row) entries. 
-In columns BO through BQ, convert minimum, maximum, and mean elevations relative 
to the mean low water tidal datum. To do so, use NOAA Vertical Data Transformation 
Tool (VDATUM).  
 -Select region (Contiguous United States for all of our study sites) 

-Horizontal Information: set source and target to reference frame = 
NAD83(2011), coor. system = projected UTM (Easting, Northing), unit = meter, 
zone = 18 (noc), 17 (niw, ace, sap, gtm). 
-Vertical information: set source to reference frame = NAVD88, unit = meter, 
select height, check geoid model → GEOID18 (unless you used a different GEOID 
during RTK surveys of reefs). Set Target to reference frame = MLW, unit = meter, 
select height, check geoid model → GEOID18 (unless you used a different GEOID 
during RTK surveys of reefs). 

https://vdatum.noaa.gov/vdatumweb/
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-Point conversion: input northing and easting coordinate of reef (or use the map 
below), enter height = 0, click ‘transform’, the output height is the offset 
between elevations in mNAVD88 and m MLW. Add the output height (keeping 
the sign of the output height) to minimum, maximum and mean elevations in 
mNAVD88 to convert to MLW.  
 -For example at the Pivers Island Reef in NOC, an elevation of 0m  
 NAVD88 = MLW elevation of 0.601m. The offset of 0.601m would be  
 added to minimum, maximum and mean elevations in mNAAVD88 to  
 convert to MLW.   

 
3.4. Terrain Ruggedness Index (TRI) 
3.4.1. Clip DEM to reef boundary layer 

-Analysis  Tools  Clip Raster (Data Management Tools) 
-Input Raster:  Selected site corrected DEM 

   -Make sure this is the pre-excavation AND corrected DEM 
  -Output Extent:  Site_Reef_Boundary_Layer 
   -Note, this layer is generated in section 3.2.1 above 

-Output Raster Dataset: Site_DEM_Reef_Clip 
-Make sure output raster dataset is within the project geodatabase 

-Check ‘Use Input Features for Clipping Geometry’ 
-NoData Value: 999  
-*Click Run 

 
3.4.2. Generate Mean Elevation Raster 

-Analysis  Tools  Focal Statistics (Image or Spatial Analyst Tools) 
 -Input raster:  Site_DEM_Reef_Clip 
 -Output raster: FocalSt_Site_Year_DEM_Mean 
 -Neighborhood: Rectangle 
  -Width: 3 
  -Height: 3 
  -Units type: Cell 
 -Statistics type: Mean 
 -Check ‘Ignore NoData in calculations’ 
 -*Click Run 
 

3.4.3. Generate Maximum Elevation Raster 
-Analysis  Tools  Focal Statistics (Image or Spatial Analyst Tools) 
 -Input raster:  Site_DEM_Reef_Clip 
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 -Output raster: FocalSt_Site_Year_DEM_Max 
 -Neighborhood: Rectangle 
  -Width: 3 
  -Height: 3 
  -Units type: Cell 
 -Statistics type: Maximum 
 -Check ‘Ignore NoData in calculations’ 
 -*Click Run 
 

3.4.4. Create Minimum Elevation Raster 
-Analysis  Tools  Focal Statistics (Image or Spatial Analyst Tools) 
 -Input raster:  Site_DEM_Reef_Clip 
 -Output raster: FocalSt_Site_Year_DEM_Min 
 -Neighborhood: Rectangle 
  -Width: 3 
  -Height: 3 
  -Units type: Cell 
 -Statistics type: Minimum 
 -Check ‘Ignore NoData in calculations’ 
 -*Click Run 

 
3.4.5. Generate TRI Raster 
 -Analysis  Tools  Raster Calculator (Image or Spatial Analyst Tools) 
  -Map Algebra expression: 
(‘FocalSt_Site_Year_DEM_Mean’ –  ‘FocalSt_Site_Year_DEM_Min’) / 
(‘FocalSt_Site_Year_DEM_Max’ – ‘FocalSt_Site_Year_DEM_Min’) 
 

-Output raster: Site_Year_TRI 
  -*Click Run 
 
3.4.6. Run zonal statistics on TRI raster 

-Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: Site_quad_polygon 
  -Zone Field:  quadrat_id 
  -Input Value Raster: Selected site TRI 
  -Output Table: ZonalSt_Site_Year_TRI 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
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  -Percentile Values: 90 
  -*Click Run 

*Open ZonalSt_Site_Year_TRI table 
-Copy the values from ‘Count’ to ‘Pct90’ and paste in columns BR to CA of the 
workflow_density_database.xlsx (\imagery_data_spreadsheets). 

-In column CB of the workflow_density_database.xlsx, standardize ‘Sum’ values in 
column BY of the data template by quadrat area in column BS of the data template 
using the following formula: ‘=IF(BY2="", "", BY2/BS2)’. Drag the formula down for the 
remaining quadrat (row) entries. 

 
3.5. Vector Ruggedness Measure (VRM) 
3.5.1. Download and install ArcHydroPro Package (Appendix 1) 
 
3.5.2. Generate VRM Raster 

-Analysis  Tools  Vector Ruggedness Measure (archydropro) 
  -Input Elevation Raster: Site_DEM_Reef_Clip 
   -Note, this layer is generated in section 3.4.1 above 

-Neighborhood Distance: 1 centimeter 
  -Window Size: 3 

-Output Raster: Site_Year_VRM 
-Be sure to save in the project geodatabase or the tool will not render a 
raster data layer 

-*Click Run 
 
3.5.3. Run zonal statistics on VRM raster  

-Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: Site_quad_polygon 
  -Zone Field: quadrat_id 
  -Input Value Raster: Site_Year_VRM 
  -Output Table: ZonalSt_Site_Year_VRM 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  -*Click Run 

*Open ZonalSt_Site_Year_VRM table 
-Copy the values from ‘Count’ to ‘Pct90’ and paste in columns BZ to CI of the 
workflow_density_database.xlsx (\imagery_data_spreadsheets). 
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-In column CM of the ***_workflow_density_database.xlsx, standardize ‘Sum’ values in 
column CJ of the data template by quadrat area in column CD of the data template using 
the following formula: ‘=IF(CJ2="", "", CJ2/CD2)’. Drag the formula down for the 
remaining quadrat (row) entries. 

 
**Make sure to record the time in minutes it takes to complete a reef or site in column CR of 
the ***_workflow_density_database.xlsx, being sure to divide that time up among quadrats 
for a given reef (i.e., if steps 1-3 take 300 minutes and you have 5 quadrats, enter 60 minutes 
in each row). 
 
-Export the ArcGIS project (.ppkx) 

-Share tab → Project (left side). 
-Start packaging = “Save package to file”. 
-Item details = change the file location and name, as appropriate. 

-If the projects are reef-specific, save the files as: 
xxx_zz_mmddyy_density.ppkx, where xxx = reserve initials, zz = reef 
initials, mmddyy = date sampled (e.g., noc_mm_071423_density.ppkx). 
-If the projects are workflow-specific, and contain all reefs, save the file 
as: xxx_allreefs_yyyy_density.ppkx, where xxx = reserve initials, yyyy = 
year sampled (e.g., noc_allreefs_2023_density.ppkx). 
-For the experimental reefs, save the files in one of the two formats 
listed above, and add ‘_experiment.ppkx’ at the end of the name (e.g., 
noc_mm_030824_density_experiment.ppkx). 

-Select the checkbox for “Share outside of organization”. Make sure all other 
checkboxes are unselected. 

  
**Steps 1.0 through 3.0 will need to be completed for each site (and over time if oysters were 
counted following removal as part of the experimental manipulation).  

4. Generate density predictions using generalized additive model  
-In columns CN of the workflow_density_database.xlsx (where *** is the reserve abbreviation), 
use the following formula to generate reef easting centroid: ‘=IF(B2="","",B2)’  
 - Drag the formula down for the remaining quadrat (row) entries. 
-In columns CO of the workflow_density_database.xlsx, use the following formula to generate 
reef northing centroid: ‘=IF(C2="","",C2)’ 
 - Drag the formula down for the remaining quadrat (row) entries. 
-In columns CP of the workflow_density_database.xlsx, use the following formula to generate 
reef harvest status (0 = closed, 1 = open): ‘=IF(H2="","",IF(H2="Closed", 0, 1))’ 
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 - Drag the formula down for the remaining quadrat (row) entries. 
-In columns CQ of the workflow_density_database.xlsx, use the following formula to generate 
reef type (0 = patch, 1 = fringe): ‘=IF(G2="","",IF(G2="Fringe", 1, 0))’ 
 - Drag the formula down for the remaining quadrat (row) entries. 
-Statistical modeling to predict oyster density will be done outside of ArcGIS Pro and MS Excel 
given the modeling complexities associated with the multitude of explanatory variables (and 
multivariate combinations therein).  
-We will adopt a generalized additive modeling (GAM) approach sensu Windle et al. 2022. 
Model scripts were coded in R (the R script is located: 
\image_analysis_workflows\GAM_density_predict_validate_in-situ_quad_archive.R). 
-The input data is located:  \image_analysis_workflows\GAM_density_input_data_archive.xlsx 

-GAM predictions for oyster recruit density (< 25mm in length), submarket density  
(26-74  mm), market density (75+ mm), and total density and associated standard errors 
will be  appended to the workflow_density_database.xlsx (columns CS-CZ). These  
predictions will be used to compare in-situ density estimates with imagery-based 
density estimates.  

5. Generate estimated density map layer 
-Open the ArcPro footprint project for the site and export 1) Reef footprint polygon feature and 
2) Site boundary feature into the density project geodatabase. 
 -Contents pane  Right click on reef footprint polygon  Data  Export Feature 
 -*Save as a new feature in the density project geodatabase. 

-Repeat with site boundary feature 
 
-In the density project, click Add Data and add both the footprint and site boundary 
 
5.1 Create Density Grid 
 -Analysis  Tools  Create Fishnet (Data Management Tools) 
  Output Feature Class: SiteYear_density_grid 
 -Template Extent: Select site boundary 
 -Check Extent Coordinate System: Make sure it is correct 
 -Cell Size Width: 0.25 
 -Cell Size Height: 0.25 

-Uncheck ‘Create Label Points’ 
 -Geometry Type: Polygon 
 -*Click Run 
 
5.1.1. Create Label Grids 

https://www.mdpi.com/2072-4292/14/9/2163
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          -Open density grid fishnet layer attribute table 
          -Click create new field 
          -Enter: Field Name (‘Grid_Number’), Alias (‘Grid_Number’), Date Type (‘Text’), Allow  
 Null (‘check’); click save 
           
          -Right click on header of new field (Grid_Number) 
                       -Select Calculate Field Tool 
                       -Input Table: Site_density_grid 
                       -Field Name: Grid_Number 
                       -Expression Type: Python 
                       -Grid_number = !OID! 
 
5.2. Extract explanatory variables for entire reef 
5.2.1. Run zonal statistics on RGB Orthomosaic 
 -Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: SiteYear_density_grid 
  -Zone Field: Grid_Number 
  -Input Value Raster: Select site RGB Orthomosaic clipped to reef 
  -Output Table: ZonalSt_Site_Year_grid_Ortho 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  -*Click Run 
 
5.2.2. Run zonal statistics on Iso cluster raster 

-Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: SiteYear_density_grid 
  -Zone Field: Grid_Number 
  -Input Value Raster: Select site Iso Cluster clipped to reef 
  -Output Table: ZonalSt_Site_Year_grid_Iso 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  -*Click Run 
 
5.2.3. Run zonal statistics on DEM 
 -Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: SiteYear_density_grid 
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  -Zone Field: Grid_Number 
  -Input Value Raster: Select site DEM clipped to reef 
  -Output Table: ZonalSt_Site_Year_grid_DEM 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  -*Click Run 
 
5.2.3. Run zonal statistics on TRI raster 
 -Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: SiteYear_density_grid 
  -Zone Field: Grid_Number 
  -Input Value Raster: Select site TRI 
  -Output Table: ZonalSt_Site_Year_grid_TRI 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  *Click Run 
 
5.2.4. Run zonal statistics on VRM raster 
 -Analysis  Tools  Zonal Statistics as Table (Image or Spatial Analyst Tools) 
  -Input Raster or Feature Zone Data: SiteYear_density_grid 
  -Zone Field: Grid_Number 
  -Input Value Raster: Select site VRM 
  -Output Table: ZonalSt_Site_Year_grid_VRM 
  -*Check ‘Ignore NoData in Calculations’ 
  -Statistics Type: All 
  -Percentile Values: 90 
  -*Click Run 
 
5.3. Join zonal statistics into one table 
 -In the contents pane, right click on the SiteYear_density_grid table and select copy. 
 -Paste the copied table under Standalone Tables in the Contents Pane and rename to  
 SiteYear_density_grid_combined. 

-Analysis  Tools  Add Join (Data Management Tools) 
  -Input Table: SiteYear_density_grid_combined 
  -Input Field: Grid_Number 
  -Join Table: ZonalSt_SiteYear_grid_Ortho 
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  -Join Field: Grid_Number 
  -*Check keep all input records 

-*Click “Validate Join” to check 
-*Click Run 

-Open the SiteYear_density_grid_combined attribute table to check the join was added 
correctly. 

 -Repeat step 5.3 using the Add Join Tool for DEM, TRI, ISO, and VRM tables. 
 
5.4. Export combined table 
 -Analysis  Tools  Table to Excel (Conversion Tools) 
  -Input Table: SiteYear_density_grid_combined 
  -Output Excel File: ZonalSt_SiteYear_densitygrid_combined_TableToExcel.xlsx 
  -*Click Run 
 
5.5. Generate Density Predictions Using Generalized Additive Model  
 -Follow step 4.0 to generate prediction densities for each reef grid cell.    
 -The R script for predicting densities for each reef grid cell is located:  
 \image_analysis_workflows\GAM_density_predict_reef_grid_archive.R 

-The input data files are located at the following: 
 -\image_analysis_workflows\GAM_density_input_data_archive.xlsx 

  -\image_analysis_workflows\noc_ci_reef_density_pred_archive.xlsx 
 

-Add table with density predictions to ArcGIS project folder. 
-In ArcPro, click add data to add 
ZonalSt_SiteYear_densitygrid_combined_Predicted.xlsx” table to the project. 

          -The table should now appear in the Contents Pane under “Standalone Tables”. 
-Analysis  Tools  Add Join (Data Management Tools) 

  -Input Table: SiteYear_density_grid 
  -Input Field: Grid_Number 
  -Join Table: ZonalSt_SiteYear_densitygrid_combined_predicted 
  -Join Field: Grid_Number 
  -*Check only ‘keep common’ 

-*Click “Validate Join” to check 
-*Click Run 
-Open the SiteYear_density_grid attribute table to check that the join was added 
correctly.    

 
5.6. Create Reef Extent 
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5.6.1. Add a buffer to reef footprint 
 -Analysis  Tools  Buffer (Analysis Tools) 
  -Input Features: SiteYear_classified_Footprint 

-Output Feature Class: SiteYear_classified_Footprint_buff_add1m 
-Distance [value or field]: Linear Unit 
-Distance: 1 Meters 
-Side Type: Full 
-Method: Geodesic 
-Dissolve Type: Dissolve all output feature into a single feature 
-*Click Run 
-Re-run buffer tool with adjusted buffer distance if buffer is excessive or 
insufficient. 

 
5.6.2. Fill holes in reef footprint 
 -Analysis  Tools  Eliminate Polygon Part (Analysis Tools) 
  -Input Features: SiteYear_classified_Footprint_buff_add1m 

-Output Feature Class: SiteYear_classified_Footprint_buff_filled 
-Condition: Area 
-Area: set to an area size larger than the voids in the site footprint that need to 
be filled (example 1000 m2). 
-Check eliminate contained parts only 
-*Note: This tool can be run again with “Eliminate parts only”, Condition: Area, 
and Area set to small unit (i.e., 1 m2) to remove small, miss-classified footprint 
polygon artifacts (typically caused by glare). 

 
5.6.3. Subtract buffer (optional) 

-This step can be taken to remove excess or unwanted areas extending well past the 
reef footprint that are unhelpful in modeling oyster reef density (i.e., water or marsh 
areas that would be better depicted by the ortho raster layer). 

 -Analysis  Tools  Buffer (Analysis Tools) 
  -Input Features: SiteYear_classified_Footprint_buff_filled 

-Output Feature Class: SiteYear_classified_Footprint_buff_filled_final 
-Distance [value or field]: Linear Unit 
-Distance: -0.5 m 
-Side Type: Full 
-Method: Geodesic 
-Dissolve Type: Dissolve all output feature into a single feature 
-*Click Run 
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5.7. Create map of modeled oyster density 

-Analysis Tools  Clip (Analysis Tools) 
  -Input Features or Dataset: SiteYear_density_grid 
  -Clip Features: Use the final Site Reef Footprint created in the last step (ex.  
  SiteYear_classified_Footprint_buff_filled_Final) 
  -Output Features or Dataset: SiteYear_density_Total 
  -*Click Run 

-In the contents pane, right click on SiteYear_density_Total and select symbology (use  
Classify as primary symbology). Select Total density as the ‘Field’. Select desired 
symbology settings for method, number of classes, and color scheme. See Figure 1 for 
an example.  

 
5.7.1 Create additional density layers 
 -In the contents pane, right click on SiteYear_density_Total and select Data → Export  
 features. 
 -Input Features: SiteYear_density_Total 
 -Output Feature Class: SiteYear_density_Recruit 
 -Click Ok 
 -Repeat step 5.7 to create a map for density of oyster recruits (being sure to symbolize  
 with Recruit density as the ‘Field’). 
 -Repeat steps 5.7 and 5.7.1 to create a map for density of submarket and market sized  
 oysters (again, make sure to symbolize by the correct ‘Field’). 
 
5.7.2. Create complimentary layers to display error associated with density estimates 
 -In the contents pane, right click on SiteYear_density_Total and select Data → Export  
 features. 
 -Input Features: SiteYear_density_Total 
 -Output Feature Class: SiteYear_density_Total_sterror 
 -Click Ok 

-In the contents pane, right click on SiteYear_density_Total_sterror and select 
symbology (use Classify as primary symbology). Select standard error associated with 
total density estimates as the ‘Field’. Select desired symbology settings for method, 
number of classes, and color scheme. 

 -Repeat steps 5.7.2 to create a layer for error associated with density estimates for  
 recruits, submarket, and market sized oysters (making sure to symbolize by the correct  
 ‘Field’).   
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Figure 1. Estimate of total oyster density (oysters per 1/16th m2) at Pivers Island, NC (2023). 
  

6. Appendix  
Downloading and Installing Arc Hydro Tools | 2023 
 

https://www.esri.com/content/dam/esrisites/en-us/media/manuals/downloading-arc-hydro.pdf
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